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ELASTODICT: EFFECTIVE ELASTIC PROPERTIES AND 

LARGE DEFORMATION SIMULATIONS 

The ElastoDict module helps in the development of new materials by providing better 

understanding of their properties. The key to optimizing your materials are accurate 
simulations on the 3D micro-structure. ElastoDict is mainly suited for structural 

materials, these might be e.g., composite materials, ceramics, metals or foams.  

As an example, composite materials play a crucial role for light weight applications, 
but the analysis of their behavior is challenging due to the highly anisotropic behavior 

and the complex damage mechanisms they exhibit. The expensive, time consuming 
and often impracticable experimental tests for the study of composites can be 

supplemented or replaced by simulation.  

Using simulation to find answers to mechanical properties and deformation questions 
is key in many application areas, where the target variables do not necessarily need 

to be mechanical properties of the materials. For example, the ElastoDict module can 
be used to simulate how the clamping pressure changes the structure of a gas 

diffusion layer (GDL) in a PEM fuel cell, or how the properties of rock samples change 
under in-situ conditions.  

All these ElastoDict simulations run at high-speed and are extremely memory-efficient 

thanks to the integrated FeelMath solver developed at the Fraunhofer ITWM.  

Since GeoDict 2022, the LIR solver is additionally available for ElastoDict-Effective 

Stiffness.  

ElastoDict contains the following sub-modules: 

◼ Deformations 

ElastoDict-Deformations simulates nonlinear large deformations. For example, a 
standard tensile experiment in an arbitrary direction of the 3D micro-structure can 

be set up. The models of the constituent materials might contain damage, failure, 
plastic deformation, viscous effects, and many more. For linear elastic materials, 
new material contacts in the structure can be detected during the simulation. To 

model the constituent materials, Abaqus UMAT’s can be used to include all kinds 
of possible effects in the nonlinear simulation. Results of the simulation are e.g., 

a stress-strain curve and local information on the regions where damage sets in 
and the material ends up failing. 

◼ Flexural Test 

With the Flexural Test option in ElastoDict, the reaction of a material to bending 
loads can be analyzed. 

◼ Effective Stiffness 

ElastoDict-Effective Stiffness computes the linear elastic properties of complex 

micro-structures by solving the corresponding partial differential equation on the 
3D image or model. For Effective Stiffness, two solvers are available: FeelMath 
and LIR. The results include the local stresses and strains, the complete stiffness 

tensor, and the information on the orthotropic, transversal isotropic or isotropic 
character of the material, indicative of directionally dependent properties. 

Additionally, many post-processing steps can be carried out on the ElastoDict-
Effective Stiffness results. 

◼ Effective Stiffness (AF) 

https://www.itwm.fraunhofer.de/en/departments/sms/products-services/feelmath.html
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ElastoDict-Effective Stiffness (AF) computes analytic approximations and bounds 

for the linear elastic properties of complex micro-structures. The computation is 
very fast, as no partial differential equation is solved, and gives a first 
approximation of the material behavior. 

◼ Mechanics GeoApps 

This section contains GeoApps which use the functionality of ElastoDict. Currently, 

two GeoApps are available: 

▪ the Stiffness Estimation GeoApp helps to estimate the stiffness on an 
unknown material 

▪ the Contact Detachment GeoApp is used to set up a simulation with the 
possibility of objects detaching from each other. 

 



 References 
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ELASTODICT WORKFLOW 

The computation of mechanical properties in ElastoDict usually follows these steps: 

1. Import 3D image data in the form of a stack of (µ)CT scan or FIB-SEM images of 
an existing material or generate a new structure model in GeoDict. 

2. Start ElastoDict and 

◼ choose the adequate solver, 

◼ set material parameters using the GeoDict material database, 

◼ run the mechanical properties computations 

◼ analyze the results 

Solid and porous structures can be used as input for computations with ElastoDict. 

The mechanical properties of all constituent materials must be given. Including the 
pore/matrix material, GeoDict handles structures with up to 256 different constituent 

materials. 

As useful convention, for solid materials, the background (Material ID 0) contributes 
to the computation and is referred to as matrix material. For porous media, 

Material ID 0 is used for the pore space (void space).  

SOLID MATERIALS 

In solid structures, all constituent materials have non-zero physical material 
parameters (e.g., Poisson’s ratio and Young’s modulus for linear elastic materials; see 
the Constituent Materials tab in page 11). In structures consisting of multiple solid 

materials, like e.g., composite materials, ElastoDict applies perfect contact at the 
interfaces between different materials. A typical example for a solid structure is a 

glass fiber reinforced composite. 

Many different material models (Plasticity, visco-plasticity, damage, …) are available 
in GeoDict and the user can implement his/her own Abaqus UMATs. 

POROUS MATERIALS 

Porous structures in GeoDict are materials where at least one constituent material is 

selected as Pore (Fluid) material, this means its Youngs’s Modulus and Poisson’s ratio 
are both set to zero. No stresses can occur in the pore space. Examples of porous 

structures are e.g. nonwovens and foams. 

It is a requirement of all ElastoDict simulations that a continuous load path exists 
through the structure. This means that the solid materials must form a connected 

component in the load direction. Otherwise, an error message below is shown, and 
the simulation cannot be started. 
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For materials in the pore space, a pore pressure can be set which leads to stresses in 

the surrounding solid materials. 

Some structures whose mechanical properties can be calculated with ElastoDict are: 

 

 

 

 

Isotropic fibrous microstructure model  

generated using FiberGeo 

Nickel Foam microstructure model 

generated using FoamGeo 

Berea Sandstone  

modeled from imported 3D data 

using ImportGeo-Vol 

Glass fiber reinforced polymer model 

generated using FiberGeo 
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STARTING ELASTODICT 

Start ElastoDict by selecting Predict → ElastoDict in the menu bar. 

 

In the ElastoDict section, located on the left side of the GUI, the solvers are selectable 
from the pull-down menu: 

1. Deformations for the computation of large deformations. 

2. Flexural Test for the computation of bending experiments. 

3. Effective Stiffness for the computation of effective stiffness based on numeric 
computations. 

4. Effective Stiffness (AF) for the computation of effective stiffness based on 
analytic formulas. 

5. Mechanics GeoApps contains apps which use the functionality of ElastoDict 
for specific applications. 

The settings (Options) can be modified through the Edit… button. The default 
parameters can be changed to user-defined parameters for the computation of 

interest.  
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For Deformations and Effective Stiffness, the Estimate Memory button is 

present in the ElastoDict section. When the structure of interest is shown in the 
Visualization area, clicking Estimate Memory calculates the memory needed for the 
computations based on the size of the structure and the parameters entered in the 

solver options. 

After entering the Solver Options, click the Run button in the ElastoDict section to 

start the computations. A progress dialog opens to follow the computations. 

 

When recording a macro, the Record button becomes active, and the Run button 
changes to Run & Record.  

Click Help to access this ElastoDict handbook through our web page. 

The button Cloud allows to perform the calculations in the GeoDict Cloud and with 

Job Queue the simulation run can be executed on a job queue server. More 
information on how to start a calculation in the cloud or the job queue can be found 

in the High Performance Computing handbook of the GeoDict User Guide.  

If interested in cloud simulations contact Math2Market to apply for a GeoDict cloud 
license. 

During the computation, the ElastoDict solver process can be cancelled or stopped by 
clicking the Cancel or Stop button in the progress dialog.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ElastoDict&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024&heading=ExecuteInJobQueue
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With Cancel, the computation is terminated, and no further action is taken. With 

Stop, the computation is terminated, and the results file is updated to the current 
state of the computation. Then, the result file is loaded and shown in the Result 

Viewer. With the  button, the console is opened which shows additional 

information about the solver run.  

The Release Floaters button is for floating license users only. Pressing this button 

frees all non-required floaters and makes them available again for other users, see 
the Settings section of the GeoDict GUI, Menu, and Toolbar Reference handbook for 

more information. 

Depending on the solver’s internal processes and actual memory usage, terminating 
the computation may not be instantaneous.

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=BasicVolume&release=2024&heading=Preferences
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DEFORMATIONS 

Click the Options’ Edit… button to set the simulations settings for deformation 

simulations.  

 

In the Large Deformation Options dialog, choose a Result File Name (*.gdr) 
according to your current project. 

 

If a GeoDict results file (*.gdr) with the given name already exists in the project 

folder, a warning message is shown at the start of the creation process.  

The user may decide to back-up the old file, to overwrite it, or to choose a new file 

name. If no action is taken, the default option Back-Up is automatically chosen after 
a waiting time. Then, the old results files are copied to the folder 00GeoDictBackUp 
in the current project folder.  
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Additional to the results file with the given name, also a corresponding results folder 

with the same name is written into the current GeoDict project folder. The results file 
in combination with the results folder contains all information about the current run 
and allows to reproduce the simulation. 

RESTARTING A SIMULATION 

Deformation simulations can contain many steps, and therefore it may be necessary 

to interrupt a simulation. Such simulations can be restarted with the option Continue 
interrupted simulation. Click Browse to select the corresponding result file and 
then Run to restart the simulation.  

 

For more information about the requirements for continuing interrupted simulations, 

see page 34.  

If a simulation cannot be continued, a corresponding error message is shown.  
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CONSTITUENT MATERIALS 

The materials in the structure model need to be defined under the Constituent 
Materials tab, so that their mechanical parameters, such as the Young’s modulus (E) 

and the Poisson’s ratio (), are taken into account.  

The material for a material ID can be selected by clicking on the corresponding 
material name. Then, the Material Selector dialog is opened. 

The mechanical properties of the structure’s constituent materials are taken directly 
from the GeoDict Material Database. To enter the material parameters for a linear 
elastic material manually, choose Manual (Solid) as material. 

 

Any values entered manually e.g., those for a user-defined constituent material, can 
also be added to the material database through the Edit Material Database… 

button. Nonlinear materials can also be created in the GeoDict Material Database. 
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For materials from the material database, the View… button on the right in the 

Constituent Materials tab shows all parameters of the material. 

 

  



Deformations 

GeoDict 2024 User Guide  13 

For Manual materials, the View… button on the right in the Constituent Materials 

tab changes to Edit… and allows to edit all parameters of the material. 

 

More information on editing, expanding, and using the GeoDict Material Database is 
available in the Material Database handbook. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2023
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MACROSCOPIC LOAD CASE 

The parameters which define the general conditions of the Macroscopic Load Case 
are Experiment and Load Type. Their choice defines which other parameters are 

available for the experiment.  

 

EXPERIMENT 

◼ Uniaxial Experiment – Tensile / Compression / Shear allows to set up 

experiments with one load direction (Tensile, Compression or Shear Experiments). 
The load can be time-dependent, e.g., cyclic. See more on Uniaxial Experiment 

starting on page 16. 

◼ Complex Load Experiment allows to define more elaborate load scenarios, e.g., 
a tensile experiment followed by a shear load or multiple load directions at the 

same time. The load directions can be defined freely as a combination of normal 
and shear loads. See more on Complex Load Experiment starting on page 20. 
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LOAD TYPE 

◼ Path Controlled:  

specify the mean strain in the geometry (for geometric linear experiments) or the 
mean displacement gradient in the geometry (for geometric nonlinear 

experiments) in the load direction. 

◼ Force Controlled:  

Specify the mean stress in the geometry (for geometric linear experiments) or the 
mean nominal stress in the geometry (for geometric nonlinear experiments) in the 
load direction. It is important to note that the mean stress is computed with 

respect to the complete geometry. If a structure consists of solids and pore space, 
this means that the average load on the solids is larger than the given mean stress, 

since the load in the pore space is zero. 

Generally, Path controlled should be preferred over Force Controlled if 
possible. One of the challenges with Force Controlled is the fact that the Strain-

Stress curves for plastic materials are often very flat: This means that a small 
change in stress can lead to a very large change in strain. On the other hand, a 

small change in strain leads to an even smaller change in stress. Therefore, the 
Path Controlled simulation is much easier to compute. For simulations with 

damage, Force controlled may be even impossible to solve (because the given 
stress might be higher than the maximal stress allowed by the material), while 
Path Controlled can always be solved (see also page 106).  

BOUNDARY CONDITIONS 

Here, the domain boundary conditions for the strain (and stress respectively) may be 

set to Periodic, Symmetric, or Mixed. Note that displacements do not need to hold 
these boundary conditions. 

In general, periodic boundary conditions should be used for periodic structures, 

whereas otherwise symmetric or mixed boundary conditions may be applied.  

Mixed boundary conditions mean that symmetric boundary conditions apply in the 

load direction, whereas periodic boundary conditions apply in the tangential 
directions. Mixed boundary conditions can only be used for tensile, or compression 
loads along the coordinate directions. In the figure below, periodic and symmetric 

boundary conditions are illustrated for a non-periodic structure. 

The structure below was created as an example and does not have a real counterpart. 
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When periodic boundary conditions are applied to non-periodic structures, it might 

lead to stress peaks at the boundaries as illustrated below for a uniaxial load. 

 

However, simulations with periodic boundary conditions are much faster and need 
less memory than simulations with symmetric boundary conditions.  

In many cases, for example for composite structures with low fiber percentage, the 
results for periodic boundary conditions are comparable with the results for symmetric 

boundary conditions even if the analyzed structure is not periodic. Therefore, it is 
recommended to work with periodic boundary conditions until the best simulation 
settings are found and only use symmetric boundary conditions in the final simulation. 

UNIAXIAL EXPERIMENT AND COMPLEX LOAD EXPERIMENT 

Uniaxial Experiment 

In a Uniaxial Experiment, the load is applied in one given direction. This direction 

can be either given by one of the coordinate directions (X, Y, Z), a given angle to one 
of the coordinate directions in each coordinate plane (e.g., XZ or YZ), or a shear 
experiment can be defined. 

The available load types are Tensile, Compression or Shear. The choice of Tensile 
or Compression only affects the sign of the loads, for example negative tension 

equals compression. 
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Load Case 

The choices available for the Load Case vary depending on whether Tensile, 

Compression or Shear is selected. For Tensile and Compression experiments, a 
direction, a Plane, and an Angle in Plane must be defined. For Shear, the Shear 

Load must be selected. If Without Geometric Nonlinearity under the Geometry 
Handling tab is chosen, three different shear loads are available: Here, the theory of 

small deformations applies, therefore the Shear in XY direction corresponds the shear 
in YX direction. Thus, three different shear options are available in this case: XY, XZ 
and YZ. 

When the theory of small deformations does not apply (With Geometric 
Nonlinearity), there are three different cases for shear in X and Y directions: Shear 

in XY direction, shear in YX direction (the deformation gradient is asymmetric in those 
cases) and symmetric shear in X and Y directions (this is a superposition of the two 
other cases, the deformation gradient is symmetric in this case). Thus, nine different 

shear options are available for the geometric nonlinear case. 

Refer to the Geometry Handling section for more information about the geometry 

options. 

Experiment Conditions 

The load conditions in the directions tangential to the load direction can be Free (zero 

mean stress/nominal stress in the geometry), Confined (zero mean 
strain/displacement gradient in the geometry) or Mixed. Free means that the 
structure can expand or contract freely to the load direction, whereas there is no 

expansion/contraction for confined boundary conditions. With Mixed tangential 
boundary conditions, two different conditions (Free or Confined) can be selected for 

the two tangential directions. 

Fluid Pressure 

When the structure for the simulation contains pores, a fluid pressure model can be 

selected. With No Pressure, no pressure is applied (this is the default case). With 
Fixed Pressure, a fixed pressure can be given. This fixed pressure is applied at the 

start of the ElastoDict computations. With the third option, Pressure Per Step, the 
applied pressure can be defined for each simulation step. These pressure steps must 
be entered in the Load Table (see further explanation below). 



Effective elastic properties and large deformation simulations with ElastoDict 

18  GeoDict 2024 User Guide 

The pressure is always applied to all fluids in the structure. This means that it is not 

only applied to pores in the material, but also to the fluid which surrounds the 
structure. 
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Load definition (Load Table and Predefined Shape) 

The load steps to be computed need to be specified in the Load Table, where a plot 

of the load curve can be seen under the Load Graph subtab. It is also possible to use 
a load curve of Predefined Shape like Linear, Sawtooth, or Sine, by selecting it 

from the pull-down menu on the right and clicking Apply, to set it in the Load Table 
and visualize it under Load Graph.  

For the shapes Linear and Sine there is also the option to define the thermal 
conditions by setting the Temperature Change / (K) for the Linear shape and 
Temperature Amplitude / (K) for the Sine shape  

In Case Pressure Mode → Pressure Per Step is chosen, additionally to the load 

and temperature curve, the fluid pressure curve can be defined in Predefined Shape 
by setting the Pressure Change / (GPa) for the Linear shape or Pressure 

Amplidute / (GPa) for the Sine shape.  

 

  

  

 

The load table can be 

loaded from and saved to a *.txt file with the Load… and Save… buttons. 

 

Alternatively, the data from the load table can be entered from other software like 

Microsoft Excel® via copy and paste. 

The time information from the load table is only used if the materials in the structure 
have a time-dependent behavior. When working with UMATs, this time information is 

passed to the UMAT. 

Complex Load Experiment 
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For a Complex Load Experiment, the complete mean stress (nominal stress) or 
strain (displacement gradient) tensor for the geometry can be defined. 

In this way, combinations of multiple loads directions are possible (e.g., biaxial load, 
triaxial load…). The load directions can be defined freely as a combination of normal 

and shear loads. In the screenshot below, a tensile strain of 2 % in X-direction, a 
shear load of 1 % in XY-direction and a tensile strain of 5 % in Z-direction is set. 

 

Possible options for Time Step Mode are One Step or Time Series.  

Whereas One Step consists of a single load step, a Time Series may consist of 
several load steps (Length of Load Sequence: 1, 2, 3…), where each load step (Load 
1, Load 2, Load 3… tabs) is defined by a Load End Time, number of Time Steps per 

Load and a Load Scenario. The Load Scenario can be Tensile, Compression, 
Shear or User Defined.  

The total time of the load is the difference of the current Load End Time and the 
previous Load End Time; therefore, the load end time must be strictly increasing. 
Each load is divided in a given number of Time Steps per Load. The concept is 

illustrated in the following figure: 
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The load sequences can be combined as desired. The user can e.g., do a compression 

in X-direction followed by a compression in Y-direction and a shear load. 

In the example below, the 3rd load is subdivided into 10 time steps (Time Steps per 

Load) and the load scenario is Tensile. 

 

EXAMPLE: SETTINGS FOR UNIAXIAL COMPRESSION 

In this example, we set a compression by 5 % along the z-axis. Choose Uniaxial 

Experiment - Compression as Experiment and Path Controlled as the Load Type 
(to prescribe the compression ratio). 

Keep the default settings for Load Case to compress along the Z-axis. The tangential 
boundary condition should be chosen depending on the needs, here we set it to Free 
to allow expansion in tangential direction. The Pressure Mode is set to No Pressure 

as there is no fluid pressure applied.  

Under Predefined Shape, choose Linear, set a Magnitude of 5 %, a Length of 

5 s, and a Number of Steps of 5. Generally, the time and number of steps should 
be chosen depending on the user’s needs. More steps always mean more computing 
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time. After the settings for the Predefined Shape are made, click Apply to update 

the Load Table to these values.  
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GEOMETRY HANDLING 

The Geometry Handling tab contains all options related to geometry changes 
during the simulation.  

 

DEFORMATION TYPE 

Under Deformation Type, the theory which is used for the structural mechanics is 

selected: 

◼ Without Geometric Nonlinearity: This approach is faster and more reliable than 

the geometric nonlinear case. More material models are available in GeoDict for 
this case (e.g., Plasticity and Damage models). The boundary conditions for this 
experiment type are given as mean strains or mean stresses in the analyzed 

volume. 
◼ Here, the infinitesimal strain theory applies (see more information on 

Wikipedia). This is the linearized form of the finite strain theory (which applies 
to With Geometric Nonlinearity). 

◼ It is assumed that only small deformations occur, for example it is assumed 

that no rotations occur. 

◼ This is the simpler theory, but it is much more robust and easier to solve and 

is therefore preferable in most use cases. We recommend to always try 
Without Geometric Nonlinearity first. 

◼ For applications with larger deformations use Without Geometric 

Nonlinearity with Calculate on Deformed Geometry on (see page 24). 

◼ The usual strain and stress definitions apply only here. 

◼ With Geometric Nonlinearity: Should be used when the theory of small 
deformations does not hold anymore. A nonlinear problem must be solved; 
therefore, the computation might be considerably slower than for the geometric 

https://en.wikipedia.org/wiki/Infinitesimal_strain_theory
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linear case. The boundary conditions for this experiment type are given as mean 

displacement gradient or mean nominal stresses in the analyzed volume. 
◼ Here, the finite strain theory applies (see more information on Wikipedia) 

◼ Here, large deformations are considered, this means that also the effect of 

rotations is considered correctly.  

◼ This theory is more complete, but also much more complicated to solve (Finite 

Strain Theory).  

◼ Here, many different definitions for the stresses and strain are possible. The 
usual strain and stress definitions do not apply here. Nevertheless, if the 

deformations are small, the strains in the nonlinear definitions do not deviate 
largely from the strains in the linear definition (e.g., for small strains, the Green 

Lagrange Strain is close to the Strain for Without Geometric Nonlinearity). 

The difference between the geometric linear and nonlinear case is not special to 

GeoDict. This concerns all structural mechanics simulations – one always needs to 
choose between the simpler, but robust theory (Without Geometric Nonlinearity) 
and the more general theory (With Geometric Nonlinearity), which is much more 

complicated to solve and understand, but necessary in some cases. The two options 
(“With/Without Geometric Nonlinearity”) might have slightly different names in other 

software, but the theory behind them is the same. 

CALCULATE ON DEFORMED GEOMETRY 

With Calculate on Deformed Geometry checked, the deformed geometry is re-

sampled, and this geometry is used for the calculations in the next step. With this 
method, it is possible to detect new object contacts during deformation and e.g., to 

observe the effect of stiffening during compression. Calculate on Deformed 
Geometry can only be used without geometric nonlinearity. 

A resampling step is done if the conditions defined under Geometry Update are met. 

It is important to choose these settings appropriately for the current geometry and 
deformation steps: With each resampling step, discretization errors occur, and these 

errors accumulate if too many resampling steps are done. Therefore, the resampling 
should only be done after a significant change in the geometry size. This can be 
achieved by choosing the mode Size Control for Geometry Update (see page 25). 

◼ Off: The deformation is always calculated relatively to the original geometry 

 

Deformed 

geometry 1 

Deformed 

geometry 2 

Deformed 

geometry 3 

Original 

geometry 

Apply load  

step 1 

Apply load  

step 2 
Apply load  

step 3 

https://en.wikipedia.org/wiki/Finite_strain_theory
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◼ On:  

If the conditions defined under Geometry Update are met, the deformed 
geometry is calculated, and the deformation is calculated relative to the previous 
geometry. In the figure below, the behavior of the setting All for Geometry 

Update is shown. 

 

KEEP VOLUME FRACTION OF DEFORMED GEOMETRY 

If Keep Volume Fraction of Deformed Geometry is checked, the accurate volume 
fraction information for each material ID after the deformation is kept and updated in 

memory. Refer to page 26 for further information about the volume fractions. This 
needs more memory but leads to a more accurate geometry deformation if many 

(small steps) are computed. Without this information, the volume fractions are 
converted into a structure in each deformation step and the volume fraction gets lost. 

  

GEOMETRY UPDATE 

Under Geometry Update, it can be selected when the next simulation step is 

computed on the newly deformed geometry, or if it is computed based on the existing 
geometry. 

Use the mode Size Control for the Geometry Update when using Calculate on 

Deformed Geometry. With this mode, the size of the deformation is checked after 
each step.  

Only if the deformation is larger than the given threshold, Calculate on Deformed 
Geometry is used for this step. Otherwise, the step is done without Calculate on 

Original 

geometry 
Deformed 

geometry 1 
Deformed 

geometry 2 

Apply load  
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Apply load difference  

from step 1 to step 2 

Apply load difference  
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Deformed Geometry. We strongly recommend using this mode for simulations of 

this type.  

 

◼ All – The geometry is updated in every step  

 

◼ Step Control – Choose how often the geometry is updated with Update 
Geometry Each n-th Step.  

 

◼ Size Control – If the geometry is updated or does not depend on the change of 
the domain size. If the size change for one domain side is larger than the value 

defined for Geometry Change / %, the geometry is updated.  

 

RESAMPLING 

For Resampling, two options can be chosen: Maintain Volume or Maintain Mass. 

Deformation in ElastoDict is computed and stored as a displacement field. For each 
voxel, this displacement field contains the information on how far it is displaced in the 

current deformation step.  

Internally, the new material positions are calculated based on this displacement 
information. Since the new positions do not necessarily lie on the voxel grid, a gray 

value image with material Volume Fractions is computed for each material ID. These 
volume fractions contain the information “how much” of a given material is contained 

in a voxel after the deformation. These volume fractions must be resampled to the 
voxel geometry. In the figures below, this resampling is shown in a simplified example 
for one material ID. The deformed geometry is generated by thresholding the 

resulting gray value image containing the volume fractions. 
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With Maintain Volume, the resampling threshold is chosen in such a way that the 

volume of each solid material in the structure stays roughly the same. With Maintain 
Mass, the threshold for each voxel is set to 0.5. This means, Maintain Volume is a 

good choice when it is expected that the volume of a material does not change during 
the deformation. When deformations occur where the volume of the material changes 
significantly during the computations, e.g., thermal expansion or expansion due to a 

negative Poisson’s’ ratio, Maintain Mass should be used. 

ENABLE OBJECT TRACKING (*.G32) 

With the object tracking option, a *.g32 file with the object indices for all objects in 
the structure is created for each deformed geometry. This way, the deformation of 
each object in the structure can be tracked during the deformation.  
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OBJECT MODE 

The choice for Object Mode depends on the available information: If a structure 
with analytic object information (e.g. from GeoDict’s structure generator modules 

FiberGeo, GrainGeo, FoamGeo, …) is used, this information can be used with Use 
Analytic Objects (gad). In this case, a *.g32 file with object indices is 

automatically created and saved in the results folder. If no analytic object 
information is available, Load Object Information from File (*.g32) must be 
selected and a *.g32 file must be loaded. A *.g32 file can be created e.g. with 

GrainFind for all grains in the structure. 

In the example below, a weave structure from WeaveGeo with the corresponding 

object indices is shown before and after deformation in ElastoDict. These structures 
can be loaded directly from the result viewer with the corresponding buttons (shown 
below). 
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SOLVER 

Internally ElastoDict uses an iterative solver to solve the equations that describe the 
mechanical problem at each voxel. The basic idea of an iterative method is:  

1. Start with an initial guess for the unknown values. 

2. Improve the current values in each iterative step. The speed of the improvement 

depends on the problem parameters. 

3. Repeat the iterative process until one of the stopping criteria occurs. 

SIMULATION STOPPING CRITERION 

The iterative process of the solver is controlled by setting the values for Tolerance, 

Maximal Iterations, and Maximal Run Time (h). Only the tolerance must be set, 
the two other parameters are optional. 

For each iteration step, the relative error of the current solution is computed. If this 
relative error is smaller than the given tolerance, the computation is finished. When 
there is doubt about the quality of the solution, decrease the tolerance value by a 

factor of ten for that solver. In general, it is recommended to keep the default setting 
for tolerance. 

 

When the solver stops because the Maximal Iterations or the Maximal Run 
Time (h) are reached, the quality of solution might be doubtful since the requested 
accuracy is not achieved. Therefore, those two options are disabled by default and 

should only be selected if there are strong constraints on the allowed runtime. 

METHOD 

For the FeelMath solver, three different iterative methods are available: Fast 
(Conjugate Gradient), Intermediate (Memory Efficient Conjugate Gradient) 
and Memory Efficient (Neumann Series). 
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The Fast method converges faster, especially for strongly varying material 

parameters and nonlinear material laws (as e.g. plasticity or damage), but needs 
about four times as much memory as the Memory Efficient method.  

The Intermediate Method needs approximately 40 % less memory than the Fast 

method but is 20-30 % slower. The Estimate memory button, in the ElastoDict 
section (see page 7), can be used to decide which method is applicable for the current 

structure on the available computer. 

In general, it is recommended to use the default (Memory Efficient Conjugate 
Gradient) or the Conjugate Gradient method. The Neumann Series method 

should only be used if the memory is not enough for the other methods. 

PARALLELIZATION 

The ElastoDict run can be accelerated by using multiple CPU cores. The 
Parallelization Options dialog opens when clicking the Edit... button, to choose 
between Local Sequential, Local Parallel, Local Maximum and Cluster. On Linux, 

Local MPI Parallel is additionally available.  

 

The number of Threads to run can be entered after choosing Local Parallel. Local, 
Maximum is the default and provides the fastest possible computation based on the 

available and licensed processes. With Local, Sequential, only one thread is used, 
and no parallel computation is done.  
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For information on how to set up the Number of Nodes and Processes per Node 
to use ElastoDict in a Cluster configuration, contact Math2Market support. 

USE DOWNSAMPLING 

Downsampling reduces the structure size by combining multiple voxels. By default, 
the Downsampling Factor is set to two – this means that 2x2x2 voxels are 

combined to one voxel. The material model used for each voxel in the downsampled 
structure is a combination of the material model (e.g., a Composite Voxel) of the 

original voxels. Since the simulated structure size is much smaller than the original 
structure, Downsampling allows to speed up the simulation and to quickly obtain 
results even on computers with little memory. This option should not be used if 

highest accuracy is required. 

In most cases, a Downsampling Factor of 2 is the best choice, but it can also be 

set to 4 if needed. Then, the computation will be faster, but the results could be more 
inaccurate.  

 

To be able to use downsampling, the features (e.g., fibers or grains) in each material 

ID must have a diameter of at least the Downsampling factor in voxels (e.g., 2 voxels 
for a Downsampling Factor of 2). Otherwise, the computation of the material 

properties might not work properly. Since GeoDict 2021, an error message is shown 
if all features in the structure are smaller than this diameter, and the simulation 
cannot be started. 

COMPOSITE VOXELS 

Two different methods to compute the Composite Voxels: Laminate Theory (the 
default), and Arithmetic Mean. When using Laminate Theory, the composite 
material properties are computed based on the laminate theory of composite 

materials. With this option, also direction dependent properties are represented 
correctly. With Arithmetic Mean, the material properties of the composite voxel are 

the average of the material properties of the original voxels. This method is less 
accurate, but the simulation might be more stable, especially if the structure contains 
many pores (as e.g., in foams). Nevertheless, it is recommended to keep the default 

Laminate Theory in most use cases for the higher accuracy. 

mailto:support@math2market.de
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WRITE DEFORMATION DATA TO FILE 

For the computation of the deformed structures, intermediate data is computed 
which describes the displacement for each voxel. Before this computation, it is not 
clear how large this data will be, since a voxel in the original structure might be 

partially moved in multiple voxels in the deformed structure. Therefore, this data 
might not fit in the main memory of the computer. Due to this, the deformation 

data was always written to the hard drive in GeoDict 2020 and before. Nevertheless, 
there is an issue with this approach: Writing and loading data form the hard drive is 
many times slower that writing and loading data in the main memory (even if the 

drive is an SSD). This causes a bottleneck, which can slow the simulation down. 

Therefore, GeoDict 2021 and later allows to keep the deformation data in memory. 

This is the new default, since the data fits in the main memory in most cases, and 
this option is many times faster (See benchmark results on page 50f.).To get the 
old behavior from GeoDict 2020 and before, check the option Write Deformation 

Data to File. We recommend keeping this option disabled, and to select it only if 
the simulation fails because the data doesn’t fit in the RAM. 

ORIENTATION MODE 

ElastoDict can handle non-isotropic constituent materials. For these materials, an 
orientation has to be additionally specified. If the analyzed structure consists of 

analytical objects (gad data), the orientation of these objects is used when Use 
Orientation from Analytic Objects (gad) is selected. 

Alternatively, with Load Orientation Information from File (*.gof), orientation 
information can be loaded from a file. Such a file can be generated for example with 

GrainFind for granular structures. The third option, Use the Global XYZ-Coordinate 
System, allows to use anisotropic materials even if no orientation information for the 
structure is available. 
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OUTPUT 

The options available in the Output tab control which information is saved to the hard 
disk during the computation. Choosing only the necessary variables might help to 

save computation time.  

 

WRITE ALL STEPS 

When Write all Steps is chosen, the results fields selected under Write Volume 

Field are written after each computation step. Otherwise, the number of steps after 
which the results fields are saved can be selected. When computing with many steps, 

disabling Write all Steps saves considerable computation time. 

DEFORMED GEOMETRY 

When Write Deformed Geometry is chosen, a geometry with the current 

displacements is resampled and saved after each step. Deformed geometries are 
written at each step, even if Write all Steps is disabled. Writing the deformed 

geometries is mainly interesting for visualization purposes and to check possible 
problems in the simulation setup when Calculate on Deformed Geometry is chosen 
in the Geometry Handling tab. 
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With Write Volume Fields on Deformed Geometry, also the result fields are 

resampled with the current displacements so that they match the deformed 
geometries. 

With Write Volume Fractions for Deformed Geometry, the volume fractions for 

each material ID in each voxel after the deformation are written to the *.das files. 
This information is necessary for the computation of the deformed geometries (For 

further understanding, check out the explanations on page 26). In general, it is not 
necessary to select this option. 

Depending on which options have been chosen in the Geometry Handling tab, some 

Deformed Geometry options might be checked unchangeable for the user. In this 
case, the tick is visualized in green. For example, if Calculate on Deformed 

Geometry and Enable Object Tracking (*.g32) is chosen, Write Volume Fields 
for Deformed Geometry is selected by default and can’t be deselected by the user.  

 

ALLOW RESTART FOR DEFORMATION SIMULATIONS 

If you want to be able to restart a simulation after an interruption, the complete stress 
and strain information must be saved for each step. With the option Allow Restart 

for Deformation Simulations, the necessary volume fields are automatically 
checked under Write Volume Field below and therefore saved. 
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Since GeoDict 2022, restarting is also available for simulations with On Deformed 

Geometry. 

WRITE VOLUME FIELD 

Checking or un-checking the boxes for Displacement, Stress, and Strain 

determines whether these results outputs are available for visualization and post-
processing after the run of the ElastoDict-Deformations. Additionally, it is possible to 

save the deformed geometry and to save the solution fields (for stress and strain) for 
the deformed geometry. Depending on the structures size, the result files can become 
large (up to several GB), so it is recommended to deselect all options which are not 

needed for the current task. 

For nonlinear materials, additional state variables might be defined. For example, for 

plastic deformation, these are the elastic and plastic strains. For materials with 
damage behavior, this is the damage variable. When Material State Variables is 
checked, these variables are saved as volume fields. 

EXPORT VTK FILE 

Besides using GeoDict’s own visualization tools, it is possible to export the solution in 

the commonly used VTK (Visualization Toolkit) format (see: https://vtk.org/ and, 
https://www.paraview.org/). 

 

https://vtk.org/
https://www.paraview.org/
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EQUATIONS & REFERENCES 

The differential equations solved in the simulation are listed under the Equations & 
References. Additionally, the tab contains the references for the methods used by 

the FeelMath solver in ElastoDict (see page 1 for links and general information). 
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RESULT FILE (.GDR) 

After the solver has finished, the result file (.gdr) is saved in the project folder and 
the Result Viewer opens automatically.  

In the Result Viewer, the list of all open result files and the path to them is shown 
in the header section. Results from older runs are accessible by opening their *.gdr 
files (File → Open *.gdr File… in the menu bar). The name of the result file currently 

displayed is highlighted in blue in the header section. Multiple results files can be 
opened at the same time. To compare their results, use CTRL+right-click to select 
multiple results files in the Result Viewer. The selected result files are shown side-by-

side. 

The header section and the post-processing section (left panel of the Results tab) 

can be collapsed (and expanded) by pulling up/down or left/right on the dotted line. 

The green dot in the right side of the Result Viewer indicates that the results shown 
are computed for the structure displayed in the visualization area (in memory) at this 

time. The dot is red when the structure in memory is not the one for which the values 
in the opened result file were calculated. The corresponding structure can be loaded 

by clicking Load Structure in the Result Viewer. 

When two result files have green dots, it indicates that both result files correspond to 
the structure shown in the Visualization area and might be the results from two 

simulations with different ElastoDict settings. It is also possible to Combine Results 
files. For further information, refer to the Result Viewer handbook of the User Guide.  

 

  

Collapse and expand 

Collapse and expand 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2024&%20heading%20=%20Permute
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The Result Viewer contains seven main tabs and subtabs: 

◼ Input Map - all input parameters 

◼ Log Map - solver specific values 

◼ Post Map - parameters of the current plot 

◼ Results - numerical results and plots 

◼ Report 

◼ Plots 

◼ Map 

◼ Strain/Stress Visualization - 3D data which can be loaded in GeoDict for visual 

inspection 

◼ Create Videos 

◼ Metadata - description and user defined parameters 

 

At the bottom of the Result Viewer, several buttons are available: 

 

◼ Use the Manage Data option to Clean-Up, Pack, Unpack or Rename the 
result files. For the packing and unpacking operations, the additional software 

7-zip is needed which can be installed with the GeoDict Required Tools installer. 

◼ Load the solver options that were used for the calculations into the ElastoDict 

GUI by clicking Load Input Map. 

◼ Export data: 

◼ Analyze and plot computation results in Microsoft Excel® using GeoDexcel 

provided with GeoDict by clicking Excel – Visual Basic. The generic import 
loads all information from the *.gdr file. GeoDexcel is only available for 

Windows®. See the GeoDexcel handbook of the GeoDict User Guide for more 
information. Excel – Python provides the same functionality as Excel – 
Visual Basic using Python and works on Windows and Linux. 

◼ Analyze computation results in MATLAB® using GeoDict’s MATLAB® interface 
GeoLab by clicking Matlab. All information included in the results file is 

loaded into MATLAB® automatically. 

◼ Save the information in the result file in *.html or *.pdf format by clicking 
Store as HTML or Store as PDF. 

◼ Save Plots to save images for all plots in the current results file 

◼ Close the results file by clicking Close. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoDexcel&release=2023
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INPUT MAP 

The Input Map contains all parameters which were used for the simulation. With the 
option Load Input Map at the bottom of the Result Viewer, all parameters are loaded 
into the GeoDict GUI and a new simulation with the same parameters can be started. 

 

LOG MAP 

The Log Map contains detailed information about the runtime and memory 

consumption during the simulation. 
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POST MAP 

The Post Map tab contains all information on the current plot under the Results tab. 

 

RESULTS 

The Results tab gives access to the computed values for the parameters calculated 

by the selected ElastoDict process. The Results tab is divided into two or into three 
subtabs:  

◼ The Report subtab shows the Average Strain (displacement gradient when using 
geometric nonlinearity) and Average Stress values in the experiment.  
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◼ The Plots subtab shows the stress-strain diagram by default. The parameters on 

the X/Y-Axis and the corresponding units are specified to the left of the plot. The 
new plot is created by clicking Apply. By right-clicking on the plot, it is possible 
to adjust the plot settings, for example, the font sizes, data range etc. Additionally, 

the plot can be saved as an image and the data can be saved as a *.txt file. 

 

◼ The Map subtab contains all result values. 

 



Effective elastic properties and large deformation simulations with ElastoDict 

42  GeoDict 2024 User Guide 

STRAIN/STRESS VISUALIZATION 

In the Strain/Stress Visualization tab, the computed result fields (*.das) and 
deformed geometries (*.gdt) can be loaded into the GeoDict GUI for visualization and 
postprocessing purpose. 

 

DEFORMED GEOMETRY 

Since GeoDict 2022, the deformed geometries and volume fields are saved in boxels 
(instead of voxels as before). 

Internally, ElastoDict works on boxels (cuboids with different side lengths), while 

GeoDict works on voxels (cubes).  

Until GeoDict 2021, ElastoDict automatically resampled the structure to a voxel 

structure with the original voxel length (therefore, the voxel length did not change). 

Since GeoDict 2022, ElastoDict saves the boxel structure directly. This change was 
necessary to enable the restart for simulations with On Deformed Geometry: The 

solver in ElastoDict needs the boxel structure for restarting the computations. With 
boxels, the number of elements does not change during the simulation. 

Now, the resampling to a voxel structure is done when the structure is loaded in 
GeoDict. The smallest boxel side length is selected as the new voxel length (instead 
of the original voxel length as before). With this choice, more detail can be preserved 

especially for compression simulations and the structure is shown with more details. 

It is also possible to load the structure with the original voxel length (as before in 

GeoDict 2021 and earlier). For this, the structure has to be imported by selecting 
File → Import Structure (*.gdt)… in the main GUI. The voxel length for the 

structure can be defined in Voxel Length / (µm), below the Resample to Voxels 

checkbox. It is also possible to load the boxel geometry without resampling by 
unchecking Resample to Voxels. 

The values for CropX, CropY and CropZ always correspond to the boxel geometry 
and do not represent the values of the resampled voxel geometry. 
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SOLUTION FILE 

Depending on whether the calculation was made on deformed geometry or not (see 
Geometry Handling ) the corresponding *.das file is available and can be loaded for 
each calculation step. In the example below, Calculate on Deformed Geometry in 

the Geometry Handling tab was unchecked, and thus only the Solution File (*das) 
can be loaded.  

 

By clicking on Load (for both solution file options) a selection dialog opens. The result 
values, which are checked here, are visible in the View Controls – Volume field tab 

in the GeoDict GUI after the loading step is finished. 

This is also the list of available result values which can be used if the Manual option 

is chosen for the video generation process, see Create Videos chapter on page 46. 
The choice of volume fields has to be made in the Output tab of the Large 
Deformation Options dialog before running the simulation, s. page 33. 

After loading all required components, the visualization settings can be set for these 
values separately.  
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OBJECT INDEX FILE 

The last two options in the Strain/Stress Visualization tab of the Result Viewer are 
for loading the Object Index File (*.g32). In case the calculations were done on 

deformed geometry with Enable Object Tracking (*.g32) checked (see s. 
Geometry Handling options), the corresponding index file can be loaded.  

By clicking on the Load Object File Index (*.g32) button at the bottom of the 
Stress/Strain Visualization tab the volume field with object indices of the 
undeformed structure is loaded.  
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The object indices of the deformed structure can be loaded by choosing Load for 

Deformed Object Index File (*.g32). A dialog will open with a list of indices to 
choose. Additionally, the information about the resampling from boxels to a voxel 
structure procedure (described on page 42) is displayed. 

Loading the Object Index File results for both cases in a colored representation of the 
different objects in the Volume Field tab. More information of each object can be 

viewed in the tooltip dialog. 
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CREATE VIDEOS 

The Create Videos tab allows to create a video of the current large deformation 
simulation directly from the results viewer. Click Create Video… to use the default 
settings or Edit Parameters… to set them to your needs. The video creation is 

performed with an underlying python macro which can be opened and edited with the 
Open Macro File button. 

 

After the parameters are set, click Create Video… to create the video. After the 
generation is finished, the video file is saved in the result folder and can be opened 
with the Play Video button (see screenshot below). 
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Since GeoDict 2024, it is also possible to create videos for other results than for von 

Mises strain or stress. For this, choose the Manual option in the Edit Parameters 
dialog and define the result value you want to record. The correct names for Image 
Name and Field Name can be looked up in the Status and Modules section of the 

GeoDict GUI or the solution field loading dialog described on page Error! Bookmark 
not defined..  

 

Note that Deformed Solution Files have to be calculated in the simulation, and all 
volume fields that are to be visualized in the video have to be checked in the Output 
tab (see page 33). Before starting the video generation, the original geometry needs 

to be loaded. 
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METADATA 

The Metadata tab contains a free text panel for additional input. Additionally, it 
contains the macro parameters when the simulation was started through a macro. 

 

RESULT FOLDER 

The result folder has the same name as the result file and is saved in the current 
project folder. It can be opened directly from the Result Viewer by right-clicking on 

the result file name and selecting Open Result Folder.  

 

The result folder contains the following file formats: 

◼ *.gdt: geometry data, e.g., the original structure and files with the deformed 
geometry (e.g., DeformedGeometry_1.gdt) 

◼ *.frf: Free Report Form file (e.g., EffectiveMatrix_2.frf). It contains the results 

of each solution step. This information can also be found in the Results tab in the 
Results viewer. 

◼ *.cff: coefficient file format (e.g., MaterialParameters.cff). This file contains 

the material properties of the materials in the structure as input data for the solver. 

◼ *.das: e.g., StrainStressResult_0.das. These files contain the result fields and 

can be visualized in GeoDict. They can be loaded directly from the results viewer.  
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◼ *.log: e.g., FeelMath.log. A log file of the current solver run. 

◼ *.pde: e.g., SolverParameters.pde. This file contains the parameters of the 

current simulations as input data for the FeelMath solver. 

◼ *.fmr for FeelMathRestart.fmr: If a simulation is aborted, a restart file might be 

written which contains information to be used for a restart of the simulation. These 
files can be quite large, therefore they should only be kept if the simulation will be 

restarted later. 

◼ *.gdr.bck[i]: e.g. DeformationResult.gdr.bck1: result file back-ups, which are 

generated if Back-up result file is checked in the Result Viewer → Results tab, 
s. page Error! Bookmark not defined.. 
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BENCHMARK RESULTS FOR DEFORMATIONS 

As an example, the compression of a sand control screen is shown here.  

The structure consists of 660 x 660 x 232 voxels (i.e., approximately 100 million 

voxels). A compression of 25 % is computed in 10 steps with plastic deformation of 
the structure.  

 

The computation was run on our server, with 2 x Intel E5-2697A v4 processors with 

16 cores each, running with a maximum of 3.60 GHz, and 128 GB RAM under Linux.  

Without writing the deformation data to a file, the computation with 32 processes, 

needs 50 % more memory, but the runtime is reduced by 40 % compared to GeoDict 
2020. With GeoDict 2022, the runtime is further reduced by 10 % compared to 
GeoDict 2021. With GeoDict 2023, due to the support for 8-bit structures, the runtime 

and memory increase a little. 

 

GeoDict release Runtime /h  Memory / GB 

2020 SP3 32.8 82 

2021 (r42253) 19.6 123 

2022 (r52998) 17.7 133 

2023 (r60247) 18.3 133.5 

2024 (r71884) 18.0 133.5 

 

If keeping the deformed geometry in memory is combined with downsampling, 

computation time can be reduced even further. 
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The example shown next is the compression of a foam structure.  

For a structure size of 500 x 500 x 500 voxels, a compression of 80 % is computed 
with ElastoDict-Deformations in 40 steps. 

 

Again, computations were run with 32 processes on our server mentioned above. 

Each computation is run twice, once for elastic, and once for plastic material behavior 

with GeoDict 2024 Runtimes and memory requirements for the computation with and 
without downsampling (DS), as well as for keeping the deformed geometry in memory 

(InMem) or writing the deformation data to a file (OnDrive) are compared in the 
following figures.  

With downsampling and keeping the deformed geometry in memory, runtimes can be 

reduced for the foam structure by more than 90 %, by reducing the required memory 
to 50 % for elastic case, and to 20 % for plastic case. 
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FLEXURAL TEST 

With the Flexural Test option in ElastoDict, the reaction of a material to bending 

loads can be analyzed. As in most applications in GeoDict, only a small domain of the 
structure is needed for the simulation. However, it is necessary that the structure in 

GeoDict contains the complete height of the real structure. 

 

Click the Solver Options Edit button to set the simulations settings for large 
deformation simulations. In the Flexural Test Options dialog, choose a Result File 

Name (*.gdr) according to your current project.  

 

CONSTITUENT MATERIALS 

Select the constituent materials of the structure model as indicated above in page 
11 for ElastoDict-Deformations. For the flexural test, linear and nonlinear materials 
can be used. 
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MACROSCOPIC LOAD CASE 

Under the Macroscopic Load Case tab, the experiment settings for the flexural test 
are defined. 

 

EXPERIMENT AND SAMPLE SIZE 

 

LOAD TYPE 

The bending of the beam leads to compression in the upper part of the beam, and to 
tension in the lower part. This can also be understood as a Strain Gradient and 
Stress Gradient (see also the figure below). In GeoDict, the flexural test is computed 

based on these gradients. If Flexural Deflection or Flexural Force are defined, 
these gradients are automatically computed by GeoDict. 
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The load type can be defined as Flexural Deflection or Flexural Force, or 

alternatively as Strain Gradient or Stress Gradient. It is recommended to only use 
Flexural Deflection or Flexural Force here, the other (gradient) options are expert 
options. If possible, Flexural Deflection should be used, since it usually leads to a 

better convergence behavior than Flexural Force (see page 15 and page 106 for 
further information). 

SUPPORT SPAN 

The support span is the distance between the two supporting pins, as indicated in the 

picture under Experiment and Sample Size. It must be entered in the user 
interface, since the structure in GeoDict is usually a small cutout of the full sample. 

BEAM WIDTH & BEAM HEIGHT 

The Beam Width is perpendicular to the 

beam and bending directions. It influences the 
ratio between load and deflection (since the 

beam can carry higher loads if it is wider), but 
it has no influence on the effective material 
parameters like the flexural modulus. The 

value of the Beam Height cannot be 
changed, since height of the beam is the 

height of the structure in GeoDict. 

 

 

LOAD TABLE 

In the Load Table, the load steps and the corresponding times can be defined. For 
computing the flexural modulus, one step is sufficient. More load steps are necessary 

to analyze more complicated effects like plasticity and damage. 
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SOLVER 

The Solver tab is identical to the one for ElastoDict-Deformations (see page 61). 

OUTPUT 

The options under the Output tab are identical to those for ElastoDict-Deformations 
(see page 33) 

EQUATIONS & REFERENCES 

The differential equations solved in the simulation and additional equations relevant 
for flexural tests are listed under the Equations & References. Additionally, the tab 

contains the references for the methods used by the FeelMath solver in ElastoDict 
(see page 1 for links). 
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RESULTS FILE (.GDR) 

The handling of the result file works analogous as for ElastoDict-Deformations (page 
37). Only the features specific for the flexural test are explained here in detail. 

RESULTS 

The results tab contains a table with the forces and corresponding deflections in the 
experiment. Additionally, the flexural modulus is computed based on the first step 

of the simulation. 

 

STRAIN/STRESS VISUALIZATION 

In the Strain/Stress Visualization tab, the computed result fields (*.das) and 
deformed geometries (*.gdt) can be loaded into GeoDict for visualization. 

In the example below, a flexural test is done on a beam with a material structure as 
shown on the left. On the right, the distribution of the strain in X-direction is shown, 

and it is visible that the compressed on the top (negative strain, colored in blue) 
and stretched on the bottom (positive strain, colored in red). 

Make sure, that all displacements, strains and stresses of interest are chosen in the 

Output tab to be written in the result files, see page 33. 

The simulation is based on the strain or stress gradients in the beam in the load 

direction. Therefore, it is not possible to see the bending in the results. This 
corresponds to the idea of analyzing a very small part of the beam. 
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EFFECTIVE STIFFNESS 

With ElastoDict-Effective stiffness, the effective elastic properties of a given structure 

can be computed. Effective elastic properties are the mechanical properties of a 
homogeneous material which shows the same elastic behavior as the given 

non-homogenous material. 

 

In the Effective Stiffness Options dialog, choose the Result File Name (*.gdr) 
as you wish. 

If a GeoDict results file (*.gdr) with the given name already exists in the project 
folder, a warning message is shown at the start of the creation process. The user can 

either decide to back up the old file, to overwrite it or cancel and choose a new file 
name. If no action is taken, the default option back-up is automatically chosen after 
a waiting time. 

CONSTITUENT MATERIALS 

Select the constituent materials of the structure model as indicated above in page 11 

for ElastoDict-Deformations. In ElastoDict-Effective Stiffness, only linear elastic 
materials can be used.  
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LOAD CASE 

In the Load Case tab, the loads applied to the geometry are defined. 

 

LOAD TYPE 

Choose whether the load applied to the material should be Strain or Stress from the 

pull-down menu. Choosing Strain is favorable for the solver and is often faster, but 
the choice has no effect on the quality of the solution.  

STIFFNESS MODE 

Either the Stiffness Tensor for the structure, or the effective stiffness for a selected 
direction can be computed (Stiffness X-Direction, …).  

 

The stiffness tensor contains more information and allows to understand the 

properties of the structure more thoroughly. Nevertheless, if only the information for 
one direction is needed, the option to compute only a selected direction is much 

faster.  
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STRAIN/STRESS INCREMENT 

Depending on the selected Load Type, a Strain or Stress Increment must be set. 
Generally, it is recommended to keep the default settings. Since the equation solved 
in ElastoDict-Effective Stiffness is linear, scaling the input increment (Strain 

respectively Stress) by a factor also scales the output (Stress respectively Strain) 
by the same factor. In conclusion, changing the input increment does not change the 

computed stiffness tensors.  

 

LOAD CASE 

Choose the Load Directions in which the effective stiffness should be calculated. The 
complete stiffness tensor can only be computed if all six load case directions are 
simulated (See the Appendix about the effective elastic properties on pages 130 ff. 

for an exemplary analysis of ElastoDict-Effective Stiffness results). Otherwise, only 
part of the stiffness tensor is calculated. If only parts of the stiffness tensor are 

computed, the results might be inaccurate, especially if the structure is highly 
anisotropic. Therefore, we recommend using the option to compute the stiffness in 
selected directions (see Stiffness Tensor, page 59) instead of computing only parts 

of the stiffness tensor. 

For the strain equivalence principle (see the Solver tab), each load case adds one 

column to the stiffness tensor. For the energy equivalence principle, only the entries 
of the stiffness tensor can be calculated, for which both the load case belonging to 
the column-number and the load case belonging to the row-number, have been 

solved. 

THERMAL EXPANSION 

When thermal expansion is chosen, the tensor with the thermal expansion coefficients 
is computed for the current structure. Thermal expansion is a separate load case 
independent from the strain or stress loads. The temperature change is then specified 

as Temperature Increment [K]. 
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BOUNDARY CONDITIONS 

Here, the domain boundary conditions can be set. In general, periodic boundary 
conditions should be used for periodic structures, whereas otherwise symmetric 
boundary conditions should be applied. For further explanations, see the 

corresponding paragraph in the ElastoDict-Deformations section (pages 15 ff.). 

For the FeelMath solver (explained under Solver below), periodic boundary 

conditions are usually much faster and need less memory than symmetric boundary 
conditions. In many cases, for example for composite structures with low fiber 
percentage, the results for periodic boundary conditions are comparable with the 

results for symmetric boundary conditions even if the analyzed structure is not 
periodic.  

The LIR solver is less affected by the choice of the boundary conditions. Usually, it is 
slightly faster with symmetric boundary conditions than with periodic boundary 
conditions. 

If the Stiffness Mode is set to Stiffness Tensor, only Periodic or Symmetric 
boundary conditions are available. For Stiffness in X,Y or Z-Direction, also Mixed 

boundary conditions can be set. Mixed boundary conditions are symmetric in the load 
direction and periodic in the tangential directions. They are usually faster to calculate 

than symmetric boundary conditions. 

SOLVER 

Since GeoDict 2023, two solvers are available for the Effective Stiffness calculation: 

FeelMath and LIR. The FeelMath solver is developed at Fraunhofer ITWM since over a 
decade. It is more versatile, has more features and is currently recommended for 

most use cases. The LIR solver is developed in-house at Math2Market and is already 
known and refined from other modules, like e.g. FlowDict. For effective stiffness 
calculations, it has a low memory consumption on highly porous structures, and it is 

fast with symmetric boundary conditions. 

 

Internally, both solvers solve several equations for strain and stress at each voxel by 

using iterative solvers. The basic idea of an iterative method is to: 

4. Start with some initial guess for the unknown values, 

5. Improve the current values in each iterative step. The improvement can be fast 
or extremely slow depending on problem parameters, 

6. Repeat the iterative process until the stopping criteria is fulfilled. 

The parameters for FeelMath and LIR differ and are explained in the following two 
sections. 
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FEELMATH 

The ElastoDict-Effective Stiffness FeelMath solver options are mostly the same as for 
the ElastoDict-Deformations (see page 29). Here, the Equivalence Principle can be 
chosen additionally, which is not available for ElastoDict-Deformations. 

 

EQUIVALENCE PRINCIPLE 

The Equivalence principle defines the equations which are solved for the 

computation of the effective properties of the structure. In principle, the effective 
properties are the properties of a homogeneous material with the same properties as 
the given structure. There are two approaches to compute these properties: 

◼ Based on Strain Equivalence: the stress caused by a given strain is the same for 
the homogeneous and non-homogeneous material. 

◼ Based on Energy and Strain Equivalence: the elastic energy stored in the 
material caused by a given strain is the same in the homogeneous and non-
homogeneous material. The strain equivalence is calculated additionally to the 

strain equivalence if this option is chosen.  

In ElastoDict-Effective Stiffness, either only Strain Equivalence or Energy and 

Strain Equivalence can be chosen. By computing the latter, also the deviation in 
the results of both methods is evaluated in the result file and provides a measure for 
the quality of the solution. Depending on the structure, both methods might lead to 

slightly different results. 

DOWNSAMPLING 

For Downsampling, all options are the same as for large deformation simulations 
(see page 31).  
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ORIENTATION MODE FOR ANISOTROPIC MATERIALS 

For Orientation Mode for Anisotropic Materials, all options are the same as for 
large deformation simulations (see page 32). 

LIR 

The solver parameters for the LIR solver differ from those of the FeelMath solver and 

are explained below. 

 

Relaxation 

Depending on the material parameters and geometrical structure of the structure, the 
underlying mathematical problem can vary in complexity, thus influencing the 

behavior of the solver. The more complex the problem is, the more stable the solver 
settings should be, resulting in higher number of iterations, slower time stepping, and 
longer mechanical solver run times. However, making the solver run less iterations 

and, thus, faster, implies the risk that the solver does not converge.  
For the LIR solver, this balance is managed through the Relaxation. The value 

should be between zero and two. For relaxation values smaller than one (<1.0), the 
simulation is more stable. For relaxation values larger than one (>1.0), the simulation 
is faster. 

Optimize for 

The LIR solver can Optimize for speed or memory. 
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If Speed is chosen, the solver constructs additional optimization structures. The 

runtime is decreased by up to 30 % but requires up to 50 % more memory compared 
to the other option. If Memory is chosen, then the runtime is increased by up to 
40 % but the solver requires up to 50 % less memory. 

Grid Type 

The Grid Type decides what kind of tree structure is used for the simulation.  

 

The default option LIR-Tree is the recommended grid type. The solver uses an 
adaptive tree structure called LIR-tree and needs up to 10 times less runtime and 

memory compared to the Regular Grid option.  

OUTPUT 

The ElastoDict-Effective Stiffness Output options are mostly the same as for 
ElastoDict-Deformations (see page 33).  

The option to Delete Result Folder after Simulation is only available for Effective 

Stiffness. When this option is chosen, only the .gdr file is kept after the run and the 
corresponding solver files are deleted (log files, solver input files, result files, …). This 

option is useful when only the effective properties are of interest and no result fields 
are needed.  

The option Export VTK File is not available for the LIR solver. 
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POST-PROCESSING 

The options available under Post-Processing are optional and they can also be set 
later in the Result Viewer of the result file (*.gdr) after the computations.  

The options in the ElastoDict-Effective Stiffness settings are shown here.  

 

How they look in the Result Viewer is shown below. Post-Processing in Original 
Coordinate System is always available and selected by default. All other post-

processing options are only available if all load directions (XX, YY, ZZ, YZ, XZ, and 
XY) have been previously checked under the Load Case tab. 

 



Effective elastic properties and large deformation simulations with ElastoDict 

66  GeoDict 2024 User Guide 

STRESS UNIT 

When post-processing the plots in the Result Viewer, the Stress Unit for the results 
can be selected. This choice has an effect on the values under the Report subtab and 
on the Plots subtab. The stress unit in the Results – Map subtab is always GPa. 

POST-PROCESSING IN ORIGINAL COORDINATE SYSTEM 

Check Post-Processing in Original Coordinate System to compute the 

engineering parameters and elasticity-tensor approximations in the original 
coordinate system (X, Y, Z). 

POST-PROCESSING IN PRINCIPAL MATERIAL AXES (PMA) 

Check Post-Processing in Principal Material Axes (PMA) to find the PMA of the 
material and compute the engineering parameters and elasticity-tensor 

approximations in the PMA system. This is only possible if all six load cases (under 
Load Case tab) are calculated. 

POST-PROCESSING IN PRINCIPAL MATERIAL AXES (PMA) IN THE XY-
PLANE 

Check Post-Processing in Principal Material Axes (PMA) in the XY-plane to find 
the PMA of the material in the XY-plane and to compute the engineering parameters 
and elasticity-tensor approximations in this PMA system. This is only possible if all six 

load cases (under Load Case tab) are calculated. 

COMPUTE DIRECTION-DEPENDENT STIFFNESS 

Check Compute Direction-Dependent Stiffness to calculate the material stiffness 
in the XY, XZ, and YZ plane, in the original coordinate system. Additionally, the 
material stiffness can be analyzed for arbitrary angles. With the Angle Resolution 

() setting the angle steps for this calculation is defined. 

The result file obtained after computations includes a table showing the calculated 
Young’s Modulus E in the three planes according to the entered angle resolution. 

Additionally, a plot for the direction dependent stiffness can be found in the results 
file under the Plots tab. 



Effective Stiffness  

GeoDict 2024 User Guide  67 

 

EXPORT ABAQUS UMAT FOR ANISOTROPIC MATERIAL 

When Export Abaqus UMAT for Anisotropic Material, an UMAT with the computed 

anisotropic material properties is exported and can be found in the result folder. This 
UMAT can directly used in Abaqus, or it can also be used as material in GeoDict. 

COMPUTE NORRIS APPROXIMATION 

Check Compute Norris Approximation to compute the cubic elasticity tensor 
approximation following Norris (A. Norris, Elastic Moduli Approximation, J. Acoust. 

Soc. Am. Vol 119, No 4, April 2006). See also the section about the effective elastic 
properties in the Appendix on pages 130 ff. This is only possible if all six load cases 
(under Load Case tab) are calculated. 
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EQUATIONS & REFERENCES 

The differential equations solved in the simulation are listed under the Equations & 
References. Additionally, the tab contains the references for the methods used by 

the FeelMath solver in ElastoDict (see page 1 for links). 
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RESULT FILE (.GDR) 

The handling of the result file works analogous as for ElastoDict-Deformations (see 
page 37), therefore only the features specific for ElastoDict-Effective Stiffness are 

explained here in detail. 

Clicking Load Structure in the result file loads the original structure to the 
visualization area. 

RESULTS  

The Results tab gives access to the computed values for the parameters calculated 

by the selected ElastoDict process. The Results tab contains two or three subtabs:  

◼ The Report subtab shows the values of the computed mechanical properties. 
These values can be exported in various ways by selecting an option from the 

Export pull-down menu at the bottom of the Result Viewer, see page 38 for more 
details. 

 

For ElastoDict-Effective Stiffness (AF) and ElastoDict-Effective Stiffness, if all 6 
load cases have been computed, an analysis of the effective stiffness tensors can 

be carried out on the tables shown in this view. This analysis allows to judge, 
whether the material exhibits some degree of symmetry, such as transverse 

isotropy. 

◼ In the ElastoDict-Effective Stiffness result file, the Plots subtab shows a plot of 
the direction dependent stiffness in the X-, Y- and Z-planes (see page 66 for 

further explanation). Right-clicking on the plot view allows generating an image or 
exporting the values as .txt file or save the image as .png file. 

◼ The Map subtab shows a structured list of all result values. 
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If only the stiffness in one direction is computed instead of the complete stiffness 

tensor (by selecting e.g. Stiffness in X-Direction as Stiffness Mode under the 
Load Case tab), the results report is much simpler. It contains only the Young’s 
modulus in the selected direction, and the average strain and the average stress in 

the structure (see example below). 

 

STRAIN/STRESS VISUALIZATION 

In the Visualization tab, the computed solution volume fields (*.das) and 

visualizations of the principal material axes (PMA) can be loaded. 
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See an example of the possibilities of visualizing the results from ElastoDict-Effective 

Stiffness on page 85ff. and an example on visualizations of the principal material axes 
(PMA) on pages 93ff. 

BENCHMARK RESULTS FOR EFFECTIVE STIFFNESS 

For the weave structure shown here, the effective stiffness is computed with 
ElastoDict-Effective Stiffness and the FeelMath solver. All fibers are fully resolved in 

the structure of 2,590 x 2,590 x 821 voxels (i.e., in total ~5.5 billion voxels).  

 

For strain load type and periodic boundary conditions, all six load cases are computed 
using the conjugate gradient method. 

The computation was run on our server, with 2 x Intel E5-2697A v4 processors with 

16 cores each, running with a maximum of 3.60 GHz, and 1024 GB RAM. 

To show the possible benefit of using downsampling, runtime and memory 

requirements are compared with and without downsampling, for a different number 
of processes, using GeoDict 2024 (r717123).  

Runtime results are shown in the following figure. The computation, which needs 40 h 

with 8 processes, can be run in 31 min with 32 processes and downsampling. Even 
without increasing the number of processes, the runtime is reduced by 97 %.  

The memory requirement is reduced by 97 % as well. The computation that needed 
1 TB of RAM without downsampling requires only 28 GB with downsampling and thus 

can be run on a standard laptop or desktop computer.  

The ideal speedup, i.e., getting half the runtime for twice the number of processes is 
also shown in the figure for the computation with downsampling. Computations with 

FeelMath have a very good speedup compared to the ideal line.  
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EFFECTIVE STIFFNESS (AF) 

The FeelMath-AF solver provides a fast analytic approximation of the effective elastic 

properties. It computes the Voigt (upper bound), the Reuss (lower bound) and the 
Mori-Tanaka approximations. AF stands for analytic functions, since here the 

equations are solved by an analytic approximation instead by an iterative numerical 
solver. 

 

ElastoDict-Effective Stiffness (AF) only works for linear elastic materials. 

CONSTITUENT MATERIALS 

Select the constituent materials of the structure model as indicated above on page 11 

for ElastoDict-Deformations. As mentioned above, ElastoDict-Effective Stiffness (AF) 
only works for linear materials. Choosing nonlinear materials results in an error 
message when starting the solver. 

LOAD CASE 

The Voigt and Reuss approximations can be interpreted as the ratio of average stress 

and average strain within the microstructure. The stress and strain are generally 
unknown and expected to be non-uniform.  

The upper bound (Voigt) assumes that the strain is uniform everywhere. The lower 

bound (Reuss) assumes that the stress is uniform everywhere. The Mori-Tanaka 
approximation works for Ellipsoids and circular fibers and needs the input of analytic 

data (*.gad files). 
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POST-PROCESSING 

Analogous to ElastoDict-Effective Stiffness, the post-processing options can also be 

chosen after the computation in the Result Viewer. For ElastoDict-Effective Stiffness 
(AF), only the option Compute Direction Dependent Stiffness, and the option to 
set a corresponding Angle Resolution is available. Refer to page 66 in the ElastoDict-

Effective Stiffness section for further details. 

 

RESULT FILE (.GDR) 

The handling of the result file is analogous to that of the ElastoDict-Deformations (see 

page 37). Therefore, only the features specific for ElastoDict-Effective Stiffness (AF) 
are explained here in detail. 

RESULTS 

The Results tab gives access to the computed values for the parameters calculated 
by the selected ElastoDict process. The Results tab is divided into two or three 

subtabs:  

◼ The Report subtab shows the values of the computed mechanical properties. 
These values can be exported in various ways by selecting an option from the 
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Export pull-down menu at the bottom of the Result Viewer, see page 38 for more 

details.  

An analysis of the effective stiffness tensors can be carried out on the tables 
shown. This analysis allows to judge, whether the material exhibits some degree 

of symmetry, such as transverse isotropy. 

 

◼ The Plots subtab shows a plot of the direction dependent Mori-Tanaka stiffness in 
the X-, Y- and Z-planes as well as the Voigt (upper bound) and the Reuss (lower 

bound) approximations. 

Right-clicking on the plot view allows generating an image or exporting the values 
as .txt file. 

 



Effective elastic properties and large deformation simulations with ElastoDict 

76  GeoDict 2024 User Guide 

◼ The Map subtab shows a structured list of all result values. 
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MECHANICS GEOAPPS 

GeoDict offers great automation possibilities to enhance productivity in the form of 

GeoApps. All steps done by the user in GeoDict are recorded in macros. The GeoApp 
dropdown menu in GeoDict gives access to several pre-defined macros for workflows 

that are often requested. 

There are two possibilities to access the GeoApps for ElastoDict.  

One way is to choose GeoApp → Modules → Mechanics GeoApps in the GeoDict 

main GUI. With this option, the ElastoDict section in the main GUI changes to 
Mechanics GeoApps. The two available mechanichs GeoApps are chosen from the 
dropdown menu.  

 

Another possibility is to choose a Mechanics GeoApps directly as one of the options 

in the ElastoDict section of the main GeoDict GUI. 
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When Mechanics GeoApps is chosen in the module section, two representative 

calculations are available – Contact Detachment and Stiffness Estimation.  

Choosing one of them allows the user to start a simulation much easier since only 
specific parameters need to be set. By clicking on Edit… a parameter dialog opens, 

which contains all relevant parameters and solver settings for each simulation in a 
simplified and straightforward way. 

For more information on GeoApps in general, refer to the GeoApps for GeoDict 
handbook. 

CONTACT DETACHMENT 

This GeoApp allows to use the early access version of the contact detachment feature 
introduced with GeoDict 2024. With this feature, it is possible to simulate detaching 

of contacts between objects in ElastoDict Deformations simulations. 

By clicking Edit… in the ElastoDict section of the main GeoDict GUI, the Contact 

Detachment Parameters dialog opens. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoApp&release=2024&heading=ComputeTortuosity
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EXPERIMENT TYPE 

In the GeoApp it is either possible to directly set a tensile experiment, a combined 
compressive/tensile experiment, or to use the current settings of ElastoDict 
Deformations.  

 

The tensile experiment is chosen by selecting Tension in the dropdown menu. The 

experiment is defined by the maximal tensile strain (in percentage with respect to 
the original geometry) and the number of steps to apply this strain.  

 

For the Compression and Tension experiment, a compression is applied to the 
geometry, followed by a tension. Again, both deformations are defined by the 
maximal strain (in percentage with respect to the original geometry) and the number 

of steps for each deformation.  
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For both experiments the Load Direction can be chosen (X, Y or Z) and wether the 

load steps shall be applied on deformed geometry, which is the case if Calculate on 
deformed geometry is checked. The latter should always be selected for the 
DetachContacts GeoApp. 

To keep the accurate volume fraction information for each material ID and update 
these in the memory, the Keep gray value image checkbox can be chosen. This 

option needs more memory, but leads to more accurate geometry deformation if 
many (small steps) are computed. If this option is not chosen the volume fractions 
are segmented into a structure in each deformation step and the volume fraction 

information is lost. 

If CurrentElastoDictSettings is chosen, the settings, which were defined in the 

ElastoDict Deformations dialog, are taken over and used with the GeoApp. No 
additional adjustments can be made in this GeoApp dialog. 

 

ALLOW CONTACT DETACHMENT 

If the option Allow Contact Detachment is checked, a detachment between 

different objects during the simulation run is possible.  

 

If Decompose Stress Tensor is chosen, detachment is detected as soon as the 

stress changes from compression to tension in the contact area of two objects. With 
the Contact Penalty Factor the detachment can be controlled. The higher the penalty 
factor, the later the detachment. As this option is still work in progress and the 

adjustment of the penalty factor highly dependent on the structure settings, it is 
recommended to leave this option unchecked. 
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By choosing Detach Initial Contacts, a detachment is allowed for all objects, 

especially also for those, which are attached to each other initially. Otherwise, only 
objects can be detached, which were detached initially but get attached to each other 
during the simulation. 

OBJECT MODE 

For this simulation, information about the objects in the structure is required, either 

in the form of GAD objects (choose Object Mode → UseGad) or via a G32 file, which 

can be loaded by choosing Object Mode → LoadFile. 

 

RESULT FILE (*.GDR) 

After closing the Contact Detachment Parameter dialog by clicking on OK, the 

Contact Detachment simulation is started by clicking Run. The results are stored in 
the result file previously entered in Result File Name (*.gdr) of the Contact 
Detachment Parameters dialog.  

After a successful run, the Result Viewer opens automatically at the Results - 
Report subtab. 
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In this example, a Tension experiment is simulated in which two objects were pulled 

in the Z-direction resulting in an object detachment. In the Report tab of the Result 
Viewer, the strain, which the objects undergo, is documented in the first table. As the 
Uniaxial Experiment – Tensile with a maximum of 60% strain was defined in the 

Macroscopic Load tab, the values for the Average strain for the column ZZ start 
with 0% and end in 60% after 12 steps. 

In the table below, the Average stress is displayed.  

The figure in the Plots subtab of the Results tab shows the tensile stress plotted 
over the tensile strain (which is the graphical representation of the table content of 

the Report tab). The tensile stress has its maximum for 20% strain and becomes zero 
at about 55% strain. At this point the separation of the two objects begins.  

 

In the Strain/Stress Visualization tab, the different result files can be loaded 
according to the description on page 42.  

Loading the Deformed Geometry (*.gdt) for Time Steps 1, 4, 7 and 10, for 
example, results in the four visualizations seen below in the GeoDict GUI.  

For this type of experiment, the Box Structure Rendering might be the better choice 

(as in the pictures below) since the detachment can be seen more precisely. 

Of course, the detachment process can be visualized in a video using options found 

under the Create Videos tab. See details in page 46.  
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STIFFNESS ESTIMATION 

This GeoApp estimates the stiffness for one constituent material, if the stiffness of 

the complete structure is known. 

By clicking Edit… in the ElastoDict section of the main GeoDict GUI, the Stiffness 
Estimation Parameters dialog opens. 

 

The result file name can be entered in Result File Name (*.gdr). 

The target stiffness of the structure is set in Stiffness of the structure / (GPa). 

Enter the ID number of the material for which the stiffness should be estimated in 
Estimate Stiffness for Material ID.  

The stopping criteria is defined in Tolerance / (%). If the relative error for the 

estimated structure stiffness is smaller than the specified tolerance, the estimation 
stops.  
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Finally, the Compute Direction (X, Y or Z) for the stiffness and the Orientation 

Mode are defined in their drop-down menus. Refer to page 32 for more details. In 
this example, the stiffness in Z-Direction of material with ID 01 is estimated. 

After all parameters are set, clicking OK closes the Stiffness Estimation 

Parameters dialog and the estimation is started by clicking Run. 

The estimation result is documented among others in the Results tab of the Result 

Viewer. The table shown in the Report tab summarizes the GeoApp results: besides 
the target of the structure stiffness, which is defined by the user, the stiffness, which 
is reached in the fitting process, is shown.  

 

In this example, the stiffness of the epoxy matrix (material ID00) of a composite 

structure is estimated. The table displayed in the Results - Report subtab shows 
that the estimated overall structure stiffness (Reached Stiffness) is 7.159 GPa and 

Estimated Stiffness for Material00, which is the stiffness for the epoxy matrix, is 
4.429 GPa. The fitting process in this example took 3 iterations.  
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APPENDIX I: EXAMPLES AND VISUALIZATION 

This section contains examples for ElastoDict-Effective Stiffness and for ElastoDict-

Deformations. For some of the examples, suggestions for visualizations are made. 

ELASTODICT-EFFECTIVE STIFFNESS 

The general visualization options for ElastoDict-Effective Stiffness are presented here. 
These options apply for arbitrary ElastoDict-Effective Stiffness runs. The simulation 
settings are not relevant here. 

VISUALIZING THE STRUCTURE 

The structure used in this example is shown here and the settings for the visualization 

of this image are shown below.  

 

Render the structure in 3D (by clicking ) and go to the Structure tab in the 

visualization panel (above the Visualization area). Set the Structure Renderer to 

Smooth. Then, select Transp. Mode to Volume, set the Transparent Material ID 
to 00, and set the Transparency value to 0.10.  

Usually, the material with ID 00 is set to invisible, so the transparency setting has no 

effect.  

 

Click  to open the Color & Visibility Settings dialog and check visible to enable 

visibility for the material ID 00. 
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VISUALIZATION OF DISPLACEMENT AND STRESSES 

After all selected load cases have been computed, result fields can be loaded by 
choosing the corresponding *.das file and clicking Load Results in the Result Viewer 
(*.gdr).  

 

In the next dialog, choose the components which should be visualized: Strain and 
Stress for all calculated load cases, like e.g., von Mises Strain and Stress, 
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DisplacementX, DisplacementY, DisplacementZ, and Displacement. Check the load 

cases of interest and click OK. 

 

Choose the displayed data through the Color by pull-down menu, under the Volume 
Field tab, in the Visualization panel above the Visualization Area.  

 

Tools are available for the visualization in 2D Cross Section (SEM) and in 3D 
Rendering. 

For 2D visualization, select View → 2D Cross Section (SEM) in the Menu bar. The 

control of 2D visualization parameters is also done through the Visualization panel 
above the Visualization Area. 
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The structure in the model can be set to invisible to observe only the results (Volume 
Field). For this, select View and un-check Structure in the menu bar or directly in 

the View Controls tab.  

 

In 2D and 3D Rendering, a color bar appears to the right (if the default position is not 
changed) during the visualization of the result file, indicating the gradation of the 
currently selected property.  



Appendix I: Examples and Visualization 

GeoDict 2024 User Guide  89 

Click the Edit… button to edit the Default Color Map or add a new Colormap by 

choosing Add… in the dropdown menu (and then click the Edit… button). 
Alternatively, new colormaps can also be defined in the Color Map dialog. 

 

In the Color Map dialog, define the upper and lower limits of the color scale, add 
transparency to the visualized result field, and assign a particular Color Space (RGB, 

HSV, LAB).  

The values entered in the Color Map dialog can be saved into a *.gps (GeoDict Project 

Settings) file by clicking on the first icon in the lower left corner. By clicking on the 
second icon settings can be loaded again from a *.gps file.  
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As you can observe in the histogram in the Value Range panel, the values 

concentrate in an area below a value 5.0e-05. To highlight the areas with high strain, 
we increase the Percentile Low to 80.  

 

Note how the color of the result field in the Visualization area and the histogram 
change accordingly.  
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To emphasize the areas where the strain is elevated, you can activate Transparency 

under the Volume Field tab or directly in the Color Map dialog. Make sure that No 
Interpolation is selected in the Interpolation dropdown menu and then modify the 
transparency curve in the Color Map dialog, as indicated in the image on the right.  

In the figure below, the transparency for low values is increased to see through these 
areas, and upper values with a high transparency are highlighted.  
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CLIPPING STRUCTURE AND RESULTS 

The displayed results can also be clipped spatially in all three directions (ClipX, ClipY, 
ClipZ) with the sliders or by direct input. This enables the simultaneous visualization 
of the structure and the corresponding results.  

Make sure that the structure is set to visible (View → checked Structure).  
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VISUALIZATION OF PRINCIPAL MATERIAL AXES 

When all load cases (XX, YY, ZZ, XY, XZ, YZ) have been computed, the principal 
material axis can be visualized by clicking Principal Material Axes – Strain 
Equivalence or Principal Material Axes - Energy Equivalence under the 

Strain/Stress Visualization tab of the Result Viewer. 

 

The axes are best to observe when the structure is transparent. For this, switch off 
the visualization of the results (View → uncheck Volume Fields), choose the 

Structure Renderer to Box and set the Transp. Mode to Volume (both options under 

the Structure tab in the Visualization panel).  
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ELASTODICT - DEFORMATIONS 

This section contains an example of how to simulate and visualize matrix damage 
with ElastoDict - Deformations. 

MATRIX DAMAGE 

ElastoDict-Deformations can be used to determine matrix damage in a composite 
model. In this example, E-Glass fibers are combined with an epoxy matrix. The 

structure used for this example is generated with FiberGeo.  

Select Deformations from the pull-down menu in the ElastoDict module section. 

 

In the Large Deformation Options dialog, under the Constituent Materials tab, 
set the materials to Epoxy (3501-6) with the Damage (UMAT) material model and 

Glass with the E-Glass (Isotropic) material model. The Failure Stress option for Glass 
can additionally be enabled, although it is not necessary for this example. 

   

Under the Macroscopic Load Case tab, the experiment is set to Uniaxial 
Experiment - Tensile. A maximal strain of 0.6 % is applied in 30 steps (choose 

Predefined Shape, set Magnitude to 0.6 %, Length to 0.6 s and the Number of 
Steps to 30. Click apply to set the load in the Load Table). For damage simulations, 

it is useful to choose small steps (here, 0.02 %). 
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Under the Geometry Handling tab, keep the default settings. 

Under the Solver tab, set the method to Fast (Conjugate Gradient). Keep the 
Tolerance at the default of 0.0001 since a high accuracy is important, especially for 
simulations with damage.  
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Under the Output tab, uncheck Write Deformed Geometry since generating the 

deformed geometries takes additional computation time and the deformed geometries 
are not relevant in most damage simulations (since the strain at the point of failure 
is often very low). 

Analogously, writing volume fields might take a significant amount of disk space and 
time, depending on the size of the structure. Some disk-space and computational 

time is saved by unchecking stress, strain, and displacement fields which do not need 
to be visualized. Therefore, keep only the volume fields Stress - Von Mises and 
Strain – Von Mises and the Material State Variables (containing the damage and 

failure variables in this example).  

 

Click OK to close the Options dialog and start the simulation by clicking Run in the 

GeoDict GUI main screen.  

After the simulation is finished, the result file is opened automatically in the Result 

Viewer at the Results - Report subtab.  

Under the Results - Plots subtab, the results of the deformation during the time 
series experiment are plotted as Stress-Strain chart (X-Axis: Strain Z-Dir; Y-Axis: 

Stress Z-Dir). Increasing damage leads to decreasing stiffness in the structure. 
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Choose Material00_Damage for the Y-Axis and click Apply… to plot the average 

matrix damage in the the matrix material (0 is no damage, 1 is maximal damage).  

As it can be observed in the plot, the average damage increases constantly until the 
point of failure (which can be recognized on the drop in the stress-strain curve at a 

strain of 0.56 % in the plot above), but it reaches a plateau (with a much smaller 
increase) after failure. Failure in a composite is a local phenomenon: As soon as a 

crack occurs (with a high local damage), the rest of the structure is unloaded. 
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Other graphs of interest can be plotted by changing the selections of the X-Axis and 

the Y-Axis pull-down menus.  

The original structure can be loaded with the Load Structure button.  

The Strain/Stress Visualization tab contains the volume fields of the Time Steps, 

which can be selected from the pull-down menu (here, the point of failure at 0.56 s 
is selected) and loaded by clicking Load. 

The components whose results can be visualized are checked in the list e.g., here von 
Mises Strain, von Mises Stress, Damage (Damage_0) and failure (failure_1). The 
numbers (0 in Damage_0 and 1 in failure_1) stand for the Material IDs to which the 

volume fields belong. 

 

 

Click OK, to load the components. 

In 2D and 3D Rendering, a color bar appears to the right (default position) during the 
visualization of the result file, indicating the gradation of the selected component.  

Further visualization parameters can be set under the Volume Field tab, in the 

Visualization panel above the Visualization Area. For more information, see the 
Visualization handbook. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2024&%20heading%20=%20Permute
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The structure is loaded in Z-direction, 

therefore the highest stresses in the 
material occur in the areas between 
fibers which lie closely together. 

Cracks in the matrix can be detected 
where the stresses are close to zero. 

 

The highest strain can be observed at 
cracks. There, the stiffness of the 
matrix material is lowered due to the 

damage, which leads to high strain 
values and low stress values. 

 

When damage is visualized, it is 
recommended to set the Data Range 
in the Color Map dialog to Min/Max 

or manually to a minimal value of 0.0 
and a maximal value of 1.0 (see also 

screenshot on the next page). Then, 
the fully damaged areas are clearly 
visible. 
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The crack in the material can be best visualized with the Transparency option for 

the volume field. For this, set the transparency as shown in the screenshot below: 
Choose low values (e.g. 0.2) for low damage values (in this example, for damage 
values lower than 0.75), and high values (1, which means no transparency) for high 

damage values (here, for damage values above 0.875). 

 

 



Appendix II: Nonlinear material models in ElastoDict 

GeoDict 2024 User Guide  101 

APPENDIX II: NONLINEAR MATERIAL MODELS IN ELASTODICT 

In ElastoDict, several types of nonlinear material laws are integrated. The next section 

explains how these material laws can be set up. Additionally, it is also possible to 
program user-defined material laws through the UMAT interface (see page 114)  

INTERNAL NONLINEAR MATERIAL LAWS IN FEELMATH 

Several nonlinear material laws are delivered with GeoDict and may be conveniently 
set up in the GeoDict Material Database dialog. See the Material Database handbook 

for more information.  

The available material laws are: Plasticity, Damage, Viscosity and Failure. All 

these material models are only available Without Geometric Nonlinearity. 

 

These material laws can be combined in different ways: 

◼ Plasticity, damage, and viscosity can be combined. For these combinations, only 
the exponential damage model is available. 

◼ The Mazars damage model cannot be combined with any other model. 

◼ The Failure model cannot be combined with any other model. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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LINEAR ELASTICITY 

The constants for linear elastic materials need to be defined for each material law in 
ElastoDict. All nonlinear material laws that can be selected in GeoDict’s material 
Database are based on linear isotropic elastic materials, except of the failure model, 

which is also available for transverse isotropic materials. 

 

PLASTICITY 

Plasticity in materials describes the effect that a deformation remains when the load 
is removed. In GeoDict, three different plastic material laws are available: Perfect 

Plasticity, Bilinear Hardening (Affine linear Hardening) and Exponential 
Hardening. 

For understanding plastic material laws, the two most important parameters are the 
elastic strain 𝜀𝑒𝑙𝑎𝑠 and the plastic strain 𝜀𝑝𝑙𝑎𝑠 which add up to the strain 𝜀. The elastic 

strain is recoverable, whereas the plastic strain remains in the material after 
unloading. The relation of the elastic strain 𝜀𝑒𝑙𝑎𝑠 to the stress 𝜎 is described by Hooke’s 

law, and the relation of the plastic strain 𝜀𝑝𝑙𝑎𝑠 to the stress 𝜎 is described by the 

chosen plastic material law. 

As long as the stress is lower than the yield stress 𝑌 of the material, the deformation 

is purely elastic. After this point, an increase in stress leads to a combination of elastic 
and plastic strains. The yield stress increases through the plastic deformation, which 

means that the material is elastic up to this point under a new load. Nevertheless, 
the course of the plastic material always depends on the initial yield stress. 

The three available plastic material laws differ in the relation between the plastic 
strain and the stress: 

◼ Perfect Plasticity: As soon as the initial yield stress 𝑌 is reached, the stress 

remains at that level. From this point, the elastic strain stays constant, and all 
additional strain is purely plastic. 

◼ Bilinear (Affine linear) Hardening: The stress is a linear function of the plastic 
strain 

𝜎(𝜀𝑝𝑙𝑎𝑠) = 𝑌 +𝐻 ∙ 𝜀𝑝𝑙𝑎𝑠 

where 𝐻 is the Plastic Strain Hardening Modulus.  

The plastic strain hardening modulus is not the slope of the stress-strain curve, 

since it only takes the plastic strain into account. The slope of the stress-strain 

curve (after the yield stress is reached) is the Tangential Modulus 𝑇. The Plastic 

Strain Hardening Modulus and the Tangential Modulus are related as 

https://en.wikipedia.org/wiki/Hooke%27s_law
https://en.wikipedia.org/wiki/Hooke%27s_law
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𝐻 =
𝑇

1 −
𝑇
𝐸

 

with the young’s modulus E. In the material definition in GeoDict, either the 

Plastic Strain Hardening Modulus or the Tangential Modulus can be set. 

◼ Exponential Hardening: The stress is related to the plastic strain via an 
exponential function 

𝜎(𝜀𝑝𝑙𝑎𝑠) = 𝑌 + 𝑎 ∙ (1 − 𝑒
−𝑏∙𝜀𝑝𝑙𝑎𝑠) 

with the First Hardening Parameter 𝑎 and the Second Hardening Parameter 

𝑏. 

 

ISOTROPIC AND KINEMATIC HARDENING 

Isotropic and Kinematic Hardening describe the effect of the plastic deformation 

on the yield surface (see Wikipedia: Yield Surface for further reference). 

In summary, the yield surface grows isotropically with isotropic hardening, whereas 

it moves with kinematic hardening. In real materials, the material behavior is usually 
a combination of both hardening types.  

How to set up the hardening type for a material is expert knowledge and can only be 

analyzed by measuring multiple load cycles for a material. Nevertheless, if only 
tension or compression is applied to a material, the results for both hardening types 

are the same, and it is sufficient to keep the default Isotropic Hardening when 
setting up a material law. 

VISCOSITY 

The material laws for plasticity can also be combined with viscosity to achieve visco-
plastic material behavior. Three models are available: linear Perzyna, nonlinear 

Perzyna and Michel-Suquet. 

The parameters are: 𝜀𝑒𝑙𝑎𝑠: elastic strain, 𝜀𝑝𝑙𝑎𝑠: plastic strain, 𝜎: stress, 𝑌: yield 

stress, 𝐻: plastic strain hardening modulus, 𝑎: first hardening parameter, 𝑏: 
second hardening parameter 

https://en.wikipedia.org/wiki/Yield_surface
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The three models differ in their complexity. The linear Perzyna model is the least 

complex of the three. It has only one additional parameter (the reference strain rate) 
compared to time-independent plasticity. In general, one should first try if this model 
already fits the needs. 

The other models should only be considered if the real material shows a behavior 
which is too complex for the linear Perzyna model. Both have the rate sensitivity 

parameter, which allows to define how a change in strain rate affects the material 
behavior. The Michel-Suquet model additionally has the drag stress parameter, which 
further influences the material behavior and allows to fine-tune the model. 

In general, setting up a visco-plastic material law is more complex than setting up 
time-independent materials. Measuring a stress-strain curve is not enough to explain 

the behavior of a visco-plastic material. In contrast, more complex experiments are 
necessary, like e.g. creep tests, relaxation tests or DMA measurements (Dynamic 

mechanical analysis). 

DAMAGE 

With the damage models, the stiffness of the material is decreased with increasing 

material damage: 

𝜎 = (1 − 𝐷) ∙ 𝐸 ∙ 𝜀 

with the damage variable 𝐷. The evolution of the damage 𝐷 depends on the selected 

damage model, and the damage can only increase. The initial value is 𝐷 = 0, and the 

maximal allowed value for the damage is 𝐷 = 0.99. When unloaded, the material 

deforms elastically (with the decreased stiffness) back to its initial state. 

 

Two damage models are available in GeoDict: The Exponential Damage model and 
Mazars’ Damage model (See reference on page 106). Both models are very similar 

and differ only in the way they depend on the strain. 

◼ Mazars’ Damage: The damage depends on the strain, and the degradation begins 

as soon as the strain reaches the threshold 𝑑0: 

𝐷 =  1 − 
𝑑0(1 − 𝑑2)

𝜀
 − 

𝑑2

𝑒𝑑1(𝜀−𝑑0)
, 𝜀 > 𝑑0 

with 𝑑0: minimal strain for damage, 𝑑1: damage hardening modulus, 𝑑2: damage 

evolution. 

◼ Exponential Damage: The damage depends on the strain energy 

𝑈 = 𝑈𝑒𝑙𝑎𝑠 + 𝑈𝑝𝑙𝑎𝑠 =
𝐸

2
∙ 𝜀𝑒𝑙𝑎𝑠
2 +∫ (𝜎(𝜀𝑝) − 𝑌)𝑑𝜀𝑝

𝜀𝑝𝑙𝑎𝑠

0
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which is the sum of the elastic and plastic strain energies 𝑈𝑒𝑙𝑎𝑠 and 𝑈𝑝𝑙𝑎𝑠. If no 

plastic deformations occur, the strain energy depends only on the elastic strains. 

The degradation begins as soon as the minimal energy for damage 𝑑0 is reached:  

𝐷 =  1 − 
𝑑0(1 − 𝑑2)

𝑈
 − 

𝑑2

𝑒𝑑1(𝑈−𝑑0)
, 𝑈 > 𝑑0 

with 𝑑0: minimal energy for damage, 𝑑1: damage hardening modulus, 𝑑2: damage 

evolution. 

The damage evolution formula is the same for both models, the significant difference 
is that the damage is driven by the strain for Mazars’ Damage and driven by the 
elastic strain energy in the Exponential Damage model. In other words, the damage 

criterion for Mazars depends linearly on the strains, and a quadratic relation holds for 
the exponential damage model. 

FAILURE 

The Failure model in GeoDict is closely related to the damage models, but its 
approach is simpler. Instead of the continuous damage variable D, the failure model 

knows only two states: Failure or no failure. The material fails if the Failure Stress is 
exceeded, and the stiffness is degraded to 1 % of the original stiffness. The volume 

field for the failure parameter contains a 0 for voxels without failure, and a 1 for failed 
voxels. However, when calculating with downsampling, or when calculating on 
deformed geometries, there might be also failure values between 0 and 1 resulting 

from a combination of several voxels. 

The Failure model is available for isotropic and for transverse isotropic materials. In 

the isotropic case, the reference stress is the von Mises stress, and in the transverse 
isotropic case, the stress in the respective directions is checked.  

Check the guidelines on page 106 for a comparison of the damage and failure models 
in GeoDict. 
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GUIDELINES FOR PLASTICITY, DAMAGE AND FAILURE MODELS 

The convergence for nonlinear materials can be bad if the simulation settings are not 
set up properly. Therefore, this section contains some best practices for these 

simulation types. 

BOUNDARY CONDITIONS 

Don’t use Force boundary conditions, if possible: 

With Force boundary conditions, it is possible to choose the applied load too high for 
the materials in the structure: For plastic materials and for the damage models, the 

maximal stress is limited by the material model. Therefore, applying a load which is 
higher than this maximal stress leads to unsolvable equations. 

If it is important to use force boundary conditions (as e.g., in a cyclic load case, where 

the stresses should decrease to zero again), we recommend  

◼ Do a first simulation with Path Boundary Conditions, to check out the maximal 

allowed stresses for the structure, or 

◼ Check the materials carefully to estimate the maximum allowed load. 

Nevertheless, even if the maximum allowed load is not reached, the convergence 

might be slow. For example, when using the exponential hardening model, a load 
slightly lower than the maximal allowed load might lead to strains near to infinity 

(which is also not realistic). 

DAMAGE MODELS VS. FAILURE MODEL 

The main difference between the damage models and the failure model is that the 

failure model decreases the stiffness suddenly, which introduces a discontinuity into 
the stress-strain relationship. The damage models lead to a gradual reduction of the 

stiffness. Thus, the damage models introduce no discontinuity, this means that the 
simulation is more stable and usually faster. Nevertheless, this gradual reduction of 
stiffness can be arbitrarily fast – this means that nearly the same results as with the 

failure model can be achieved. Additionally, the damage models can be combined with 
other models like e.g., plasticity. 

The main advantage of the failure model is that it is easier to set up, since it contains 
less parameters. Additionally, the damage models are not available for the transverse 
isotropic case. Altogether, it is strongly recommended to use the damage models 

instead of the failure model, whenever possible. 
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SETTING UP THE INTERNAL MATERIAL LAWS 

To set up a material law in GeoDict, first open the material data base via Settings – 
Edit Material Data Base … in the menu bar: 

 

Then, either create a new material by entering a material name and clicking the Add 
button (as shown below), or open one of the materials in the database and add a 
material law to it. 

 

When creating a new material, make sure that the Mechanical Properties are 

activated under the General tab: 

 

Switch to the Mechanical Properties tab. Here, existing material laws can be edited, 
or new material laws can be added. In the figure below, it is shown how to add a new 
material law: Enter the material law name in the field Add Material Law and click 

the Add button. 
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Then, the material parameters can be defined after selecting the material law. In the 
figure below, it is shown how to set up a material with Bilinear Hardening.  

Other material laws can be defined by selecting the corresponding fields in the 
interface. After all material parameters are defined, make sure to save the database 
with the Save Database button in the lower right corner. 
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MATERIAL FITTING FOR THE INTERNAL MATERIAL LAWS 

For nonlinear materials, finding the material parameters might be complicated. If 
measurement data for a given material is available, this data can be used to estimate 

the material parameters.  

Material fitting is available for Perfect Plasticity, Bilinear Hardening, Exponential 
Hardening and both Damage models. For the material fitting, currently no combined 

material models are available. 

Since GeoDict 2022, the material fitting routines are much faster than in previous 

versions. Now, the fitting relies on analytic formulas instead of repeated simulations 
– therefore the fitting finishes in several seconds instead of minutes as before. 

MEASUREMENT 

To fit a material law, a measurement must be loaded for the material. For this, check 
Save a Measurement under the Measurement tab of the current material law. 

 

Material data can be loaded from a *.txt file with the Load… button.  

The data must be formatted in two columns, the first column represents the strain 
values in percent, and the second row contains the corresponding stress values in 

GPa. Both columns must be separated by spaces.  
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Alternatively, data can also be entered by copy-and-paste or manually and save the 

data as a *.txt file with the Save… button. 

To plot the data, click the Update Graph button.  

 

FIT LAW PARAMETERS 

To fit the material law, select the Fit Law Parameters tab under the current material 
law. Choose a material law from the pulldown menu: 

 

The result is dependent on the start values for the fitting process. Therefore, the initial 

values can be user defined by checking Set Initial Parameters and Keep Initial 
Stiffness. 

The quality of the initial values can be checked with Plot Initial Curves. It is 
recommended to try several combinations of initial values to find good start 
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parameters for the material fitting algorithm. To edit the plot settings, right-click on 

the plot and choose Edit Axis Settings. 

The fitting algorithm stops if the error between the fit and the target (which is the 
measurement curve defined in the Measurement tab) is smaller than a threshold. This 

threshold can be defined in the Stopping Tolerance field. 

If only a part of the measurement data should be used for fitting the material laws, a 

strain range can be selected with Restrict Strain Range. This is especially useful if 
a part of the data contains effects which are not simulated by the selected material 
law, e.g., damage effects when fitting a material law for plasticity. 

 

The parameter fitting can be started by clicking Run Parameter Fitting. The fitting 

process will take several seconds, and the results are directly shown in the Fitted 
Parameters section and in the plot.  

If the result is not satisfying, the Initial Parameters can be adjusted and the 
parameter fitting process restarted. Another way of improving the result is to reduce 
the Stopping Tolerance and force the fitting algorithm to search longer for a 

solution. 

In the presented example the Initial Yield Stress has to be changed from 0.01 GPa to 

0.04 GPa to achieve a good fitting result. In the figure below, you can see that the 
curve for the exponential plasticity model lays very well over the measurement data 
after the parameter fit.  
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With the button Set Parameters to Material Law, the fitted parameters are copied 
to the material law under the Material Law tab.  

 

Finally, save the changes to the material database with the Save Database button. 
Now, the new material law is saved and can be used in ElastoDict. 
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Select the material law (here Material Law1), and make sure that the nonlinear 
material model is enabled (here: Exponential under Plasticity Model). 
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APPENDIX III: USING UMATS FOR CUSTOM MATERIAL LAWS 

The user can program their own user-defined material laws with the UMAT interface 

in GeoDict. 

UMATs are a concept from the FEA software Abaqus, and the interface is compatible 

with GeoDict. This means that you can directly use your already existing user 
materials in GeoDict. To get familiar with the syntax, some UMAT files are delivered 
with GeoDict. UMATs are Fortran files (*.f or *.f90), but in GeoDict it is also possible 

to directly use the compiled files (*.so). Nevertheless, *.so files from GeoDict 2020 
and before cannot be used in GeoDict 2021 and later, since the required compiler 

version changed. Additionally, they might be incompatible between different 
computers. Therefore, it is important to always keep the source files (*.f or *.f90). 

However, if a material can be defined by using the internal material laws (page 116), 

then we recommend using those instead of UMATs, since they are deeper integrated 
into GeoDict and easier to set up. 

EXAMPLE: SETTING UP A MATERIAL LAW FOR DAMAGE USING AN UMAT 

This section describes how to set up a material law using an UMAT. 

In the menu bar, go to Settings and select Edit Material Data Base… to access the 

GeoDict Material Database and add a new material to it. 
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After clicking Edit Material Data Base…, the Material Database dialog opens: 

 

A new material can be added to the database (or a material present in the database 
can be deleted). To do so, enter a name for the new material (e.g., Material_New) 
and click Add in the lower left corner of the Material Database dialog.  

 

Material_New appears listed in the left panel and default values appear in the right 
panel. 

Under the General tab, check Mechanical Properties to define those for 
Material_New.  

Under the newly appearing Mechanical tab, inside the Mechanical Properties 

Selection panel, enter Damage in the Add Material Law box, and click Add. 
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The parameters needed to define the mechanical properties of the new material 

appear under the panel grouped under the Law tab. 

From the Type pull-down menu, select UMAT. 

 

After selecting UMAT, a different panel opens below the Type pull-down menu, with 
the UMAT Parameters, Material Parameters, and State Variables tabs.  

Under the UMAT Parameters tab, click Browse to find the UMATs for GeoDict 2023 in 

your user folder. Select the file IsotropicLinearElasticityDamage.f UMAT and 

click Open. 
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Alternatively, enter a path to the UMAT file relative to the user folder. For this 

example, this path would be UMAT/IsotropicLinearElasticityDamage.f. Relative paths 
have the advantage that they work independently from your username. Therefore, 
material database entries can be shared easily between different PCs, as long as the 

UMAT file is present in the UMAT folder. 

 

For the material law (defined in the UMAT) to be applied to the Material_New, some 

material parameters must be entered under the Material Parameters tab. 

These material parameters, that the particular UMAT requires, can be found by 
opening the UMAT source file, if available (*.f or *.f90). To do so, simply click Edit 
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under the UMAT Parameters tab and open it with a text editor (for example, with 

NotePad++). 

 

In the opened file, the text shows that applying the IsotropicLinearElasticityDamage.f 
UMAT to Material_New requires assigning the following material parameters or 
properties (PROPS):  

◼ Young’s Modulus (E)  

◼ Poisson’s Ratio (NU) 

◼ Damage Hardening Modulus (DAMHARD) 

◼ Initial Threshold for the equivalent strain (DAMAGE0). 
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Therefore, in the table under the Material Parameters tab, manually enter the 

needed parameters (Material Parameters), their values for Material_New (Value), 
and a brief parameter explanation (Description). For example, as follows: 

 

The damage model defined in the IsotropicLinearElasticityDamage.f UMAT depends 
on the equivalent strain, which is calculated as 

𝜀𝑒𝑞 = √
1

3
 (

𝐸

1−2𝜈
−

𝐸

1+𝜈
) (𝜀𝑥𝑥 + 𝜀𝑦𝑦 + 𝜀𝑧𝑧)

2
+

𝐸

1+𝜈
[𝜀𝑥𝑥
2 + 𝜀𝑦𝑦

2 + 𝜀𝑧𝑧
2 +

1

4
(𝜀𝑥𝑦
2 + 𝜀𝑦𝑧

2 + 𝜀𝑥𝑧
2 )]. 

The degradation begins as soon as the minimal equivalent strain for damage 𝑑0 is 
reached: 

𝐷 =  1 − 𝑒𝑑1(𝑑0−𝜀𝑒𝑞), 𝜀𝑒𝑞 > 𝑑0 

with 𝑑0: minimal equivalent strain for damage, 𝑑1: damage hardening modulus. 

Next, go to the State Variables tab. State variables are internal variables of the 
UMAT, they store information which is used in the next iteration. When the State 

Variables are not properly defined, the UMAT does not work as intended, or it doesn’t 
work at all. 

For the UMAT IsotropicLinearElasticityDamage.f, there is only one state variable 

which stores the damage value. It must be defined and initialized with 0, since there 
is no initial damage in the material. The number of state variables depends on the 

particular UMAT and is not always obvious. If you need more information about UMATs 
delivered with GeoDict, ask the Math2Market support team for help. 

Finally, click Save Database at the bottom right of the Edit Material Data-Base 
dialog. 
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After saving, the newly defined material Material_New can be chosen as constituent 
material when using ElastoDict.  
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Make sure that the Damage material model is selected under Mechanical Properties 

tab. Now, the material law assigned to Material_New is applied in the ElastoDict 
calculations. 
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EXAMPLE: PLASTIC DEFORMATION WITH A UMAT 

Here, another UMAT included with GeoDict is used to simulate plastic deformation.  

In the GeoDict Material Database, the UMAT IsotropicMisesPlasticity.f is contained in 

the database entry for Aluminum and appropriate parameters are already defined 
when choosing Plastic (UMAT) and Type - UMAT under the Law tab.  

Besides the linear parameters (Young’s Modulus E; Poisson Ratio ), it includes a 

piecewise linear hardening curve that was entered beforehand under the Mechanical 

Properties – Material Law - Material Parameters tab.  

 

The plastic deformation of aluminum can be simulated in GeoDict using a solid block 

(generated through Model → ProcessGeo → Empty & Invert Structure → Create 

Empty Structure, 1x1x1 voxels, and then, Model → ProcessGeo → Empty & 

Invert Structure → Invert Structure).  
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Generally, it is recommended to check the material behavior on small 

structures. If only a single constituent material must be investigated, a structure 
consisting of a single voxel is already enough. 

In the menu bar, select Settings → Select Constituent Materials. You can choose 

the material of the voxel by clicking on the button next to the ID number under the 
Material tab (see screenshot below). In the Material Selector dialog, select 

Aluminum from the list of available (Solid) constituent materials.  

The color of the constituent material (Aluminum) may be changed via Settings → 

Color & Visibility Settings.  

The plastic deformation can be examined during a cyclic stress experiment which can 
be set up in ElastoDict. In the menu bar, select Predict → ElastoDict.  

In the ElastoDict section, select Deformations and click the Edit… button. In the 

Large Deformations Options dialog, choose to apply the load in Z-direction in a 
Uniaxial Experiment-Tensile, with Confined boundary conditions in tangential 

direction. Choose the Load Type as Force Controlled. 

 

To define a cyclic load, use the Predefined Shape option to the right of the Load 
Table (screenshot below).  

Choose the Shape as Sawtooth and the settings a shown in the screenshot.  

By clicking Apply, the settings for the predefined shape are applied and the load table 

is defined automatically. 
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The graph of the load looks as follows: 

 

Keep the default settings under the Geometry Handling tab.  

Under the Solver tab, keep the default settings as well: Before GeoDict 2022, it was 

necessary to select the Memory Efficient (Neumann Series) when using nonlinear 
material laws, but this is no longer necessary. 
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Under the Output tab, de-select Write Deformed Geometry. In this example, the 

simulation is done on a structure with only one voxel, and then, the deformed 
geometry does not provide useful information.  

After running the ElastoDict - Deformations simulation, the Result Viewer of the 

result file (.gdr) opens at the Results tab. Under the Results - Plots subtab, choose 
to plot the Strain in Z-Direction (%) in the X-Axis against the resulting Stress in Z-

Direction (GPa) in the Y-Axis, and click Apply…. 

Observe that the strain does not return to zero after the first load cycle and the plastic 
deformation remains in the material. 
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APPENDIX IV: ELASTICITY THEORY 

A material is said to be elastic if it deforms under external forces (stress), but returns 

to its original shape when the stress is removed. For small deformations, the stress 
is roughly proportional to the strain in many solids. The constant of proportionality 

between stress and strain is given by the Young’s modulus (E) which is a measure 
of stiffness. This linear relationship between stress and strain is called Hooke’s law 
and is the basis for the theory of linear elasticity. 

The general relationship (generalized Hooke’s law) between multi-axial stress and 
strain is described by using 2nd order tensors for stress and strain and the 4th order 

elasticity tensor for their relation. 

In solid mechanics, the Young’s modulus E can be experimentally determined from 
the slope of a stress-strain curve created during tensile tests conducted on a test 

specimen of the material. Most metals and ceramics are isotropic. i.e., their 
mechanical properties are the same in all directions.  

If e.g., metals are treated in a special way for example by deep drawing, they become 
anisotropic, so that the Young’s modulus depends on the direction from which the 
force is applied. Some materials, which are composites of two or more constituents, 

such as wood or reinforced concrete, are strongly anisotropic materials and display 
widely different mechanical properties when load is applied in different directions. For 

example, they exhibit a higher Young’s modulus (stiffness) when loaded parallel to 
the fibers. This is true under the assumption that the fibers have a higher Young’s 
modulus than the surrounding matrix material. 

Based on the input parameters, GeoDict solves six load cases or experiments (three 
compressions in x, y and z, and three shearing experiments) which are sequentially 

computed by the ElastoDict solver to predict the entries of the 6x6 effective elasticity 
tensor. Each of these six simulations is done by assigning load case-specific 
displacements on the boundaries of the structure and calculating the corresponding 

stresses. By averaging the stresses over the structure, the Hooke’s Law in the 
general anisotropic case is obtained, 

𝜎𝑖𝑗 = ∑ 𝑐𝑖𝑗𝑟𝑠𝜀𝑟𝑠 , 𝑖, 𝑗 ∈ {1, 2, 3}

3

𝑟,𝑠=1

 

where c is a symmetric fourth order tensor, called also elasticity tensor. Usually, the 
elasticity tensor and the stresses and strains are written in Voigt notation (see 
Wikipedia). This way, the elasticity tensor is reduced to a 6x6 matrix, and the stresses 

and strains are written as 6x1 vectors. This leads to a more compact and readable 
notation. 

Because of these symmetry properties, it is convenient to use the so-called “reduced 
suffix notation” (e.g., Chadwick et. al.) with the following index assignment: 

 

 

 

 

 

Tensor notation Index ij 11 22 33 23, 32 31, 13 12, 21 

denoted also by xx yy zz yz zx xy 

Voigt notation index I 1 2 3 4 5 6 

http://en.wikipedia.org/wiki/Deformation
http://en.wikipedia.org/wiki/Force
http://en.wikipedia.org/wiki/Proportionality_%28mathematics%29
http://en.wikipedia.org/wiki/Young%27s_modulus
http://en.wikipedia.org/wiki/Stiffness
http://en.wikipedia.org/wiki/Linear
http://en.wikipedia.org/wiki/Stress_%28physics%29
http://en.wikipedia.org/wiki/Strain_%28physics%29
http://en.wikipedia.org/wiki/Tensor
http://en.wikipedia.org/wiki/Solid_mechanics
http://en.wikipedia.org/wiki/Slope
http://en.wikipedia.org/wiki/Stress-strain_curve
http://en.wikipedia.org/wiki/Tensile_test
http://en.wikipedia.org/wiki/Isotropy
http://en.wikipedia.org/wiki/Wood
http://en.wikipedia.org/wiki/Reinforced_concrete
http://en.wikipedia.org/wiki/Anisotropy
https://en.wikipedia.org/wiki/Voigt_notation
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Then, taking into account also the symmetry of the elasticity tensor, 

𝑐𝑖𝑗𝑘𝑙 = 𝑐𝑗𝑖𝑘𝑙 = 𝑐𝑖𝑗𝑙𝑘 = 𝑐𝑘𝑙𝑖𝑗 , 𝑖, 𝑗, 𝑘, 𝑙 ∈ {1,2,3}  

The stress tensor 𝜎𝑖𝑗 can be written as 𝜎𝐼 in Voigt notation: 

 𝜎 =

(

  
 

𝜎11
𝜎22
𝜎33
𝜎23
𝜎31
𝜎12)

  
 

 

The strain tensor 𝜀𝑖𝑗 can be written as 𝜀𝐼 in Voigt notation: 

 𝜀 =

(

  
 

𝜀11
𝜀22
𝜀33
𝜀23
𝜀31
𝜀12)

  
 

 

With the Voigt notation, the symmetric fourth order elasticity tensor 𝑐𝑖𝑗𝑘𝑙 can be 

reduced to a symmetric matrix 𝐶𝐼𝐽 with the following entries (coefficients): 

 

C11=c1111=cxxxx C12=c1122=cxxyy C13=c1133=cxxzz C14=c1123=cxxyz C15=c1131=cxxzx C16=c1112=cxxxy 

 C22=c2222=cyyyy C23=c2233=cyyzz C24=c2223=cyyyz C25=c2231=cyyzx C26=c2212=cyyxy 

 C33=c3333=czzzz C34=c3323=czzyz C35=c3331=czzzx C36=c3312=czzxy 

symmetric C44=c2323=cyzyz C45=c2331=cyzzx C46=c2312=cyzxy 

 C55=c3131=czxzx C56=c3112=czxxy 

 C66=c1212=cxyxy 

Therefore, the generalized Hooke’s law can be written as a matrix-vector product: 

𝜎𝐼 =∑𝐶𝐼𝐽𝜀𝐽

6

𝐽=1

, 𝐼 = 1, . . . ,6 

(

 
 
 

𝜎𝑥𝑥
𝜎𝑦𝑦
𝜎𝑧𝑧
𝜎𝑦𝑧
𝜎𝑥𝑧
𝜎𝑥𝑦)

 
 
 
=

(

 
 
 

𝐶11 𝐶12 𝐶13 𝐶14 𝐶15 𝐶16
𝐶12 𝐶22 𝐶23 𝐶24 𝐶25 𝐶26
𝐶13 𝐶23 𝐶33 𝐶34 𝐶35 𝐶36
𝐶14 𝐶24 𝐶34 𝐶44 𝐶45 𝐶46
𝐶15 𝐶25 𝐶35 𝐶45 𝐶55 𝐶56
𝐶16 𝐶26 𝐶36 𝐶46 𝐶56 𝐶66)

 
 
 

(

 
 
 

𝜀𝑥𝑥
𝜀𝑦𝑦
𝜀𝑧𝑧
2𝜀𝑦𝑧
2𝜀𝑥𝑧
2𝜀𝑥𝑦)

 
 
 

 

: stress tensor C: elasticity or stiffness tensor : deformation 

tensor 

This elasticity or stiffness tensor describes the most general stress-strain relations for 
a linear elastic anisotropic solid (e.g., triclinic solid which has no material symmetry, 

Nayfeh, A.H. 1995).  

According to Nayfeh, the constitutive relations for the different symmetry classes can 

be listed as follows: 
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Symmetry 

class 

Number of 

parameters to 
define material 

Form of elasticity tensor 

Anisotropic 

(triclinic or 

general) 

21 

(C11, C12, C13, C14, 

C15, C16, C22, C23, 

C24, C25, C26, C33, 

C34, C35, C36, C44, 

C45, C46, C55, C56, 

C66) 

𝐶 anisotropic = 

(

 
 
 

𝐶11 𝐶12 𝐶13 𝐶14 𝐶15 𝐶16
𝐶12 𝐶22 𝐶23 𝐶24 𝐶25 𝐶26
𝐶13 𝐶23 𝐶33 𝐶34 𝐶35 𝐶36
𝐶14 𝐶24 𝐶34 𝐶44 𝐶45 𝐶46
𝐶15 𝐶25 𝐶35 𝐶45 𝐶55 𝐶56
𝐶16 𝐶26 𝐶36 𝐶46 𝐶56 𝐶66)

 
 
 

 

Monoclinic 

13 

(C11, C12, C13, C16, 

C22, C23, C26, C33, 

C36, C44, C45, C55, 

C56, C66) 

𝐶 monoclinic = 

(

 
 
 

𝐶11 𝐶12 𝐶13 0 0 𝐶16
𝐶12 𝐶22 𝐶23 0 0 𝐶26
𝐶13 𝐶23 𝐶33 0 0 𝐶36
0 0 0 𝐶44 𝐶45 0
0 0 0 𝐶45 𝐶55 0
𝐶16 𝐶26 𝐶36 0 0 𝐶66)

 
 
 

 

Orthotropic 

9 

(C11, C12, C13, C22, 

C23, C33, C44, C55, 

C66) 

𝐶 orthotropic = 

(

 
 
 

𝐶11 𝐶12 𝐶13 0 0 0
𝐶12 𝐶22 𝐶23 0 0 0
𝐶13 𝐶23 𝐶33 0 0 0
0 0 0 𝐶44 0 0
0 0 0 0 𝐶55 0
0 0 0 0 0 𝐶66)

 
 
 

 

Transversely 

Isotropic 

5 

(C11, C12, C13, C33, 

C44) 

𝐶transv.isotropic = 

(

 
 
 
 

𝐶11 𝐶12 𝐶13 0 0 0
𝐶12 𝐶11 𝐶13 0 0 0
𝐶13 𝐶13 𝐶33 0 0 0
0 0 0 𝐶44 0 0
0 0 0 0 𝐶44 0

0 0 0 0 0
𝐶11 − 𝐶12

2 )

 
 
 
 

 

Cubic 
3 

(C11, C12, C66) 
𝐶cubic = 

(

 
 
 

𝐶11 𝐶12 𝐶12 0 0 0
𝐶12 𝐶11 𝐶12 0 0 0
𝐶12 𝐶12 𝐶11 0 0 0
0 0 0 𝐶66 0 0
0 0 0 0 𝐶66 0
0 0 0 0 0 𝐶66)

 
 
 

 

Isotropic 
2 

(C11, C12) 
𝐶iso  =  

(

 
 
 
 
 
 

𝐶11 𝐶12 𝐶12 0 0 0
𝐶12 𝐶11 𝐶12 0 0 0
𝐶12 𝐶12 𝐶11 0 0 0

0 0 0
𝐶11 − 𝐶12

2
0 0

0 0 0 0
𝐶11 − 𝐶12

2
0

0 0 0 0 0
𝐶11 − 𝐶12

2 )
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The 6x6 matrix IJC  for the homogeneous material “nearest” to the inhomogeneous 

original material is shown in the *.gdr result file after the solver has finished the 

stiffness estimation computations. 

When using ElastoDict with linear laws for the constituent materials, it is important to 

keep in mind that the elasticity solver is working in the range of linear elasticity. To 
compute large deformations, plastic yield, damage effects, possible crack initiation, 
crack growth, and other nonlinear effects one has to use nonlinear material laws, 

which describe the effects under consideration, for the constituent materials. For such 
cases, the Hooke’s law does not hold. 

Nonlinear materials, e.g., for plastic deformation and damage laws are described in 
Appendix II on page 101ff. Additionally, nonlinear material laws can be defined by an 
Abaqus UMAT, see page 114 for further details. With the GeoDict installation several 

examples for UMATs are available.  
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APPENDIX V: EFFECTIVE ELASTIC PROPERTIES 

To demonstrate and discuss different ElastoDict‘s effective elastic properties, 

ElastoDict-Effective Stiffness computation results for two different fiber-reinforced 
composite structures are presented. The structures were generated with the FiberGeo 

module with isotropic and transverse isotropic fiber orientations. 

Both composite structures contain the same type of fiber (curved elliptical, diameter 
6 µm), at the same solid volume percentage, but differ in their fiber orientation. The 

isotropic structure has been generated with isotropic fiber orientation, while 
transverse isotropic structure has been generated with Anisotropy 1 = 1 and 

Anisotropy 2 = 10.  

For more information on generating isotropic and anisotropic structures, see the 
FiberGeo handbook. 

 

Here, already knowing that the fibers in the structure are isotropic or anisotropic helps 

explaining how to interpret the results obtained with ElastoDict. However, the true 
power of the ElastoDict analysis lies in cases where the orientation of the media is not 
known in advance, such as imported segmented 3D-images obtained from CT 

(Computed Tomography) scans. 

The two composite structures generated with FiberGeo, can be loaded for further 

simulations by selecting File → Open Structure (*gdt, *.gad)… in the menu bar.  

To start ElastoDict, Predict → ElastoDict has to be chosen in the menu bar. For each 

of the two runs, Effective Stiffness from the pull-down menu is selected.  

 

Isotropic structure Transverse isotropic structure 

https://en.wikipedia.org/wiki/Isotropy
https://en.wikipedia.org/wiki/Transverse_isotropy
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FiberGeo&release=2024
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In the Effective Stiffness Options dialog which opens after clicking the Edit... 

button, the values under the tabs are adjusted as seen below. For example, under 
the Constituent Materials tab, the values are adjusted to the mechanical properties 
values of Epoxy 3501-6 – Elastic and Glass – Elastic-Failure (E-Glass). 
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Click OK to close the solver options dialog and return to the ElastoDict section. After 

clicking Run, the iteration steps made during the calculation can be followed in the 
console. 

 

At the end of each of the two computations, the Result Viewer of the result files open.  
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Under the Results - Report subtab, several outputs and approximations of the result 

are provided. These approximations correspond to the different symmetry classes 
mentioned in page 128.   
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ANISOTROPIC ELASTICITY TENSOR 

The Stiffness Formulation for Strain Equivalence (GPa) is the first tensor 
displayed for the Anisotropic Elasticity tensor. It is the direct result of the 

numerical computation and the starting point for all other approximations. This tensor 
is important if you are not interested in engineering parameters (Lamé parameters) 
but instead need the most accurate relationship between the stress and the strain. A 

fully anisotropic material requires 21 distinct parameters to describe it. 

For the isotropic and the transversely isotropic composite structures being compared 

here, this tensor looks as follows: 

The values obtained for the coefficients defining the relationship between stress and 

strain can be compared to the matrix for the general elasticity tensor. 

𝐶general = 

(

 
 
 

𝐶11 𝐶12 𝐶13 𝐶14 𝐶15 𝐶16
𝐶12 𝐶22 𝐶23 𝐶24 𝐶25 𝐶26
𝐶13 𝐶23 𝐶33 𝐶34 𝐶35 𝐶36
𝐶14 𝐶24 𝐶34 𝐶44 𝐶45 𝐶46
𝐶15 𝐶25 𝐶35 𝐶45 𝐶55 𝐶56
𝐶16 𝐶26 𝐶36 𝐶46 𝐶56 𝐶66)

 
 
 
 

The other approximations of this general elasticity tensor are shown when scrolling 
down in the result file. A large difference between the full tensor and an approximation 
could mean that: 

◼ The representative volume element is too small, and a larger structure should be 
used for computations. 

◼ The chosen approximation principally does not hold. For example, it could be that 
assuming that a certain material is isotropic is false.

EffectiveStiffnessResult_Isotropic.gdr EffectiveStiffnessResult_TransverseIsotropic.gdr 
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ISOTROPIC APPROXIMATION FOR STRAIN EQUIVALENCE (GPA) 

Isotropy means independence of direction. An isotropic material can be described 

with two parameters, the Young’s modulus 𝐸, and the Poisson’s ratio 𝜈, which are the 

same in all directions. In the isotropic case there are only two independent elastic 

coefficients: 𝐸, 𝜈 or alternatively, the Lamé parameters 𝜆, 𝜇. 

For this approximation, the full 6x6 elasticity tensor is matched against the matrix for 
the isotropic symmetry class (see the section about Elasticity theory, page 126 ff.). 

From an isotropic stiffness tensor, the parameters 𝐸, 𝜈 or  𝜆, 𝜇 can be calculated as 

described below. 

 𝐶isotropic = 

(

 
 
 
 
 

𝐶11 𝐶12 𝐶12 0 0 0
𝐶12 𝐶11 𝐶12 0 0 0
𝐶12 𝐶12 𝐶11 0 0 0

0 0 0
𝐶11−𝐶12

2
0 0

0 0 0 0
𝐶11−𝐶12

2
0

0 0 0 0 0
𝐶11−𝐶12

2 )

 
 
 
 
 

 

The Lamé parameters 𝜇 (Shear Modulus) and  (Lamé Modulus) are found by 

calculating: 

From the values of 𝜇 and , the estimates for the effective Young’s modulus (𝐸) and 

effective Poisson’s ratio (𝜈) are computed as: 

Other engineering constants can also be obtained by transformation formulas (given 
e.g., by the Wikipedia page on Hooke's Law).  

For the isotropic and transverse isotropic structures, the Isotropic Approximation for 
Strain Equivalence look as follows: 

 

 𝜇 =
𝐶11−𝐶12

2
 and 𝜆 = 𝐶12  

 
𝐸 =

𝜇(2𝜇 + 3𝜆)

𝜇 + 𝜆
  

and 
𝜈 =

𝜆

2(𝜇 + 𝜆)
  

EffectiveStiffnessResult_TransverseIsotropic.gdr 

 

EffectiveStiffnessResult_Isotropic.gdr 

 

https://en.wikipedia.org/wiki/Hooke%27s_law
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Comparing the full anisotropic stiffness matrix with the isotropic approximation, the 

known structure characteristics are confirmed: the approximated isotropic stiffness 
values fit well to the corresponding values in the full anisotropic stiffness tensor. But 
for the transversely isotropic case there is a discrepancy between the approximated 

isotropic stiffness tensor and the full anisotropic one: 

 

ESTIMATED PRINCIPAL MATERIAL AXES (PMA) 

For non-isotropic materials, an appropriate coordinate system is given by the so-

called principal material axes. While the Cartesian coordinates are the direction of 
computation (and experiment e.g., taking CT and applying loads), the structure 
material has its own symmetries e.g., the plane perpendicular to the mean direction 

of the fibers. These intrinsic symmetries may not be aligned with the Cartesian 
coordinates yet define another orthonormal coordinate system. The estimation of 

principal axes is a means to find these intrinsic symmetries.  

The principal material axes are fitted as in Rutka, Wiegmann & Andrä who followed 
Browaeys and Chevrot (See references on page 129). They are shown in the results 

file and are used for approximations of the elasticity tensors. 

 

EffectiveStiffnessResult_TransverseIsotropic.gdr 

 

EffectiveStiffnessResult_Isotropic.gdr 

 

EffectiveStiffnessResult_TransverseIsotropic.
gdr 
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Here, once again, if the orientation of a structure is not known, the PMAs might give 

a hint: the PMA of the isotropic structure are more uniformly distributed than the 
transversely isotropic structure. The letter has one dominant PMA (value) for each 
coordinate of the original coordinate system (e.g. the first column: 0.99 for the x-axis 

and -0.03 and 0.02 for y-and z-axis) whereas the discrepancy in magnitude between 
the values for the isotropic structure are not high (e.g. first column: 0.64, 0.48 and 

0.58). 

If we denote by U the matrix with the new coordinate vectors: 

𝑈 = (

𝑢1 𝑣1 𝑤1
𝑢2 𝑣2 𝑤2
𝑢3 𝑣3 𝑤3

) 

Then, the coordinates of the elasticity tensor ijklc in the new coordinate system are 

𝑐𝛾𝛿𝑘𝑙
′ = 𝑈𝛼𝛾𝑈𝛽𝛿𝑈𝑗𝑘𝑈𝑗𝑙𝑐𝛼𝛽𝑖𝑗 

See the section about the elasticity theory, page 126 ff., for the relationship between 
the elasticity tensor as 4th order tensor and the matrix notation. 

ANISOTROPIC ELASTICITY TENSOR IN PMA COORDINATES 

The second matrix displayed for the Stiffness Formulation for Strain Equivalence 

shows the Anisotropic Elasticity Tensor (GPa) in PMA Coordinates. In particular, the 
difference from this tensor can be used to estimate the quality of the Orthotropic 
Approximation, Transverse Isotropic Approximation, Cubic Approximation (all in PMA 

coordinates), and Isotropic Approximation shown also in the result file. 

The Anisotropic Elasticity Tensor in PMA Coordinates looks similar to the Anisotropic 

Elasticity Tensor, but it has been transformed to another coordinate system. The 
off-diagonal coefficients are smaller, so that setting them to zero would lead to smaller 
errors. For our examples, we obtain: 

 

EffectiveStiffnessResult_Isotropic.gdr 
 

EffectiveStiffnessResult_TransverseIsotropic.
gdr 
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